
Quick Start Guide

The first pages of this manual will give you a quick overview of the 

essentials for getting around in Silo, including brief information on 

view controls, selection, manipulators, and subdivision.



View Controls

From Nevercenter 3D Modeling Wiki

Description

The following mouse controls will allow you to navigate the camera and control other viewing options in 

your Silo scene. All of these commands can be mapped to alternate mouse buttons if you prefer working

with a different setup.

Mouse Controls

Rotate: Alt + Left Mouse Button

Rotates the view with mouse drag. Rotation will occur around the manipulator.

Pan: Alt + Middle Mouse Button

Pans the view with mouse drag.

Zoom: Alt + Right Mouse Button, or Alt + Scroll

Zooms the view with mouse drag or scroll.

Cycle Shading: Ctrl + Alt + Scroll, or 0

Cycles shading modes (for example between flat shade and smooth shade).

Category: Silo Manual



Selection

From Nevercenter 3D Modeling Wiki

Description

In Silo's default selection scheme, the left and middle buttons of the mouse are used in combination with 

keyboard modifiers to perform all selection functions. Generally, left click is used to select visible elements 

(the front-most ones which can be seen on screen), while middle click is used to select through (elements 

which can be seen as well as those which are hidden by other elements but fall within the area of 

selection). Make special note of Tweak listed below, as it is one of the most useful selection tools in Silo.

All mouse controls can be modified in the Mouse Settings and all keyboard shortcuts can be modified in 

the Keyboard Settings.

Mouse Controls

Select Visible: Left Mouse Button

Use to select visible components (only the foremost components).

Select Thru: Middle Mouse Button

Use to select through components (visible components as well as components which are 
obstructed).

Tweak: Ctrl + Left Mouse Button

If nothing is already selected, then Tweak will temporarily select whatever is currently under the 
mouse, and you can drag the mouse to edit the selection with the current manipulator. When you let 
go, it will be deselected, eliminating the need for extra keystrokes before making a new selection. 
For example, you can use Tweak with the Move manipulator active to quickly grab and adjust 
vertices as you refine your model's form. If something is already selected, then Tweak will perform 
the manipulator's function on that selection, even if it isn't currently under the mouse, meaning you 
don't have to precisely grab the manipulator handle to use it. Understanding Tweak is central to 
working quickly in Silo.

Select Add: Shift

Hold while selecting to add elements to the current selection.

Select Subtract: Alt + Shift

Hold while selecting to remove elements from the current selection.

Select Complement: Ctrl + Shift

Hold while selecting to toggle elements between selected and deselected.



Select New

Select an individual element (object, face, edge, or vertex) by clicking on it with the left or middle 
mouse buttons. This will not preserve the previous selection unless modifier buttons are being held.

Select Drag

Click and drag to area select, lasso select, or paint select, depending on the style chosen from the 
Selection Style menu. This will not preserve the previous selection unless modifier buttons are being 
held.

Category: Silo Manual



Manipulators

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Path > Path

Description

Silo uses on-screen manipulators to affect the current selection. Clicking and dragging on each handle will 

have a different effect. When a manipulator is active, you can hold Control and drag to perform the Tweak

command, which performs the manipulator's action in the plane of the screen. Thus, if the the Move 

manipulator is active and you hold Control and drag with the left mouse button, you will move the 

selection in the plane of the screen without having to click on the manipulator. It is possible to work

completely without manipulators by un-checking Show Manipulator and using the Constrain To shortcuts 

available in the Keyboard Settings.

Commands

Move: W

Drag handles to move in indicated direction. The center handle moves in the plane of the screen.

Rotate: R

Drag handles to rotate in indicated direction.

Scale: E

Drag handles to scale in indicated direction. The center handle scales in all directions.

Universal: Q

A combination of the above manipulators. Handle shapes indicate function. Drag to rotate, scale, or 
move.



Category: Silo Manual



Subdivision

From Nevercenter 3D Modeling Wiki

Description

Subdivision generates a smoother, higher resolution mesh which is based on the geometry of the base 

mesh, and updates when you make changes to the base mesh. This allows you to construct and edit a high 

resolution model without having to deal with all of its geometry directly. To get a quick idea of what 

subdivision does, create a cube or some other shape and then press C one or two times to Subdivide. Try 

selecting and moving some of its faces, and you will see that even though the cube has been subdivided 

into a refined spherical shape, you are still actually working with the geometry of the original cube. Press 

V to Unsubdivide again. If you want to export or work with the high resolution mesh directly, you will 

need to Refine it, which will make the current subdivision level the new base mesh. The exception to this is 

Displacement Painting, which uses brush-like tools to manipulate the underlying mesh at any subdivision 

level without needing to refine it. No file type currently supports the transfer of subdivision or 

displacement information directly between applications, although an object can be subdivided again with 

similar results in applications which support subdivision. Displacement data can be exported via a Normal 

Map.

Commands

Subdivide: C

Subdivide creates a smoothed version of an object underlying the original object. Edits applied to the 
original polygon mesh will affect the subdivided shape. This operation can be performed multiple 
times to create a smoother underlying shape. You can use the Paint Displacement tool to displace the
smooth subdivided surface using brush tools.

Unsubdivide: V

If an object has been subdivided, Unsubdivide goes back one level of subdivision. This can be 
performed until there is no underlying subdivided shape.

Refine Control Mesh: Shift + C

Refine Control Mesh deletes the polygonal control mesh and makes the underlying subdivided 
shape at the current subdivision level directly editable.

Crease Edges

Crease Edges makes the subdivided shape more closely conform to the control mesh along the 
creased edges. Creased edges cannot be exported to other applications, unless you refine the control 
mesh.

Uncrease Edges



Uncrease Edges removes creases (if applied) from the selected edges.

Common Usage

Subdivision in Silo can be used to preview how a rendered model will look.

Notes

Subdivision behaves unexpectedly with non-manifold geometry (e.g. where more than two faces 
share a single edge). If you see "spikes" in your mesh when subdividing, this is most likely the 
cause. This is not a bug.

Category: Silo Manual



Notes for Mac Users

From Nevercenter 3D Modeling Wiki

Whenever this manual refers to Ctrl you can use either Ctrl or Cmd on your Mac.

Category: Silo Manual



Alphabe t i ca l L i s t o f 

Commands

All Silo commands are listed here alphabetically by their name within 

Silo.  A few other helpful pages are included as well.  All of these 

pages have been retrieved from the online Silo help manual at the 

Nevercenter 3D Modeling Wiki.  For the most up-to-date help info, 

visit www.nevercenter.com/wiki.



About

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Help > About

Description

This command opens a window containing information about Silo and Nevercenter.

Category: Silo Manual



Add Light

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Display > Add Light

Description

The Add Light command will create a custom light at the center of the work grid, based on parameters that 

you specify in the options window. The light will affect the scene when Use Custom Lighting is enabled 

(see Use Scene Lights).

Options

Type

Lights can be one of three types. Point lights are a single point in space which emits light in all 
directions. Directional lights are like the sun in that they emit parallel light in one direction only, no 
matter where they are placed in the scene (it's as if they're infinitely far away and have no falloff). 
Spot lights are like directional lights except that their light is restricted to a certain area by a cone, 
much like a spotlight in a theater.

Diffuse Color

This button sets the diffuse color component of the selected light.

Ambient Color

This button sets the ambient color component of the selected light.

Specular Color

This button sets the specular color component of the selected light.

Constant Falloff

This setting affects the intensity of the light. Higher numbers make the light more dim.

Linear Falloff

This setting affects the intensity of the light as objects get further away from it. This falloff has a 
linear effect, i.e. an object twice as far away will receive half as much light. Higher numbers make 
the light more dim.

Quadratic Falloff



Same as linear falloff, except the effect is amplified so that moving twice the distance away from the 
light will cause the object to receive several times less light, depending on the number entered.

Spot Cutoff

This setting adjusts how wide the angle of a spotlight will be.

Spot Exponent

This setting adjusts how the light of a spot light fades as it gets further from the center of where the 
spot light is aiming. Higher numbers make the light fade quicker as it goes from the center to the 
edges. Play around with it to find a good value for the effect you're trying to achieve.

Lock Lights to Camera

Shortcut to Lock Scene Lighting to Camera command.

Use Custom Lights

Shortcut to Use Scene Lights command.

Show Lights

Shortcut to Show Lights command.

Notes

Once a light is created, you can edit its type and settings using the Light Options or Object 
Properties dialog.
You can enter vertex selection mode while a light is selected to change its direction for directional 
and spot lights.
See Lock Scene Lighting to Camera, Use Scene Lights, and Show Lights.

Category: Silo Manual



Append Edges

From Nevercenter 3D Modeling Wiki

Default Shortcut: Shift + E

Menu Path: Modify > Append Edges

Description

Append Edges is a context-sensitive command which offers a couple of ways to add new edges (line 

segments) to your object. If you select two vertices before calling the command, then a new edge will be 

created from the selected vertices. Otherwise, you will enter an interactive edge creation tool. This tool will 

create edges with no faces attached. These edges can be useful for paths for extrusions or lathes.

Note that this tool is not used for cutting edges into existing polygons. For that, you will want to use Cut.

Context Sensitivity

Select two vertices and call this command to make an edge from those vertices.

Select an object and call this command to enter the edge tool and add new polygons to that object. You can 

click on existing vertices to incorporate those vertices into the new polygon, or click in empty space to 

create new vertices.

With nothing selected, the Edge Tool will be enabled, and you can begin to create a new object from 

scratch.

Controls

Add Vertices - Left Mouse Button

Left click to add a new vertex to the line. If you are appending to an existing object, you can either 
click on an existing vertex or click in empty space to create a new vertex.



Finish Face - Right Mouse Button

Right click to finish the current line. You will remain in the tool so you can immediately start 
drawing a new line if you choose.

Exit - Esc or Right Mouse Button

Press Esc to exit, or if you are done drawing a face, right-clicking will exit the tool.

Surface Snapping

Append Edges works with surface snapping, which means you can use it to create new geometry over the 

top of an existing model which will conform to that model. This is useful for everything from clothing to 

architectural details.

Sticky Functionality

Press and hold the keyboard shortcut for this command to temporarily enter the polygon tool, and release 

the shortcut when you are done to exit the tool. This is useful when you want to quickly create new edges 

with the tool without interrupting your workflow.

Notes

If you want to cut edges into an already existing face, use the Cut tool.
Calling Append Edges when no objects are selected will activate the Edge Tool.

Category: Silo Manual



Append Polygon

From Nevercenter 3D Modeling Wiki

Default Shortcut: P

Menu Path: Modify > Append Polygon

Description

Append Polygon is a context-sensitive command which offers a couple of ways to add new faces to your 

object. If you select three or more vertices before calling the command, then a new face will be created 

from the selected vertices. Otherwise, you will enter an interactive polygon creation tool that lets you draw 

out new faces.

Context Sensitivity

Select multiple vertices and call this command to make a polygon from those vertices.

Select an object and call this command to enter the polygon tool and add new polygons to that object. You 

can click on existing vertices to incorporate those vertices into the new polygon, or click in empty space to 

create new vertices.

With nothing selected, the polygon tool will be enabled, and you can begin to create a new object from 

scratch.

Controls

Add Vertices: Left Mouse Button

Left click to add a new vertex to the current face. If you are appending to an existing object, you can 
either click on an existing vertex or click in empty space to create a new vertex.

Finish Face: Right Mouse Button

Right click to finish the current face. You will remain in the tool so you can immediately start 
drawing a new face if you choose.



Exit: Esc or Right Mouse Button

Press Esc to exit, or if you are done drawing a face, right-clicking will exit the tool.

Surface Snapping

Append Polygon works with surface snapping, which means you can use it to create new geometry over 

the top of an existing model which will conform to that model. This is useful for everything from clothing 

to architectural details.

Sticky Functionality

Press and hold the keyboard shortcut for this command to temporarily enter the polygon tool, and release 

the shortcut when you are done to exit the tool. This is useful when you want to quickly create a new 

polygon with the tool without interrupting your workflow.

Notes

Calling Append Polygon when no objects are selected will activate the Polygon Tool.

Category: Silo Manual



Append

From Nevercenter 3D Modeling Wiki

Description

The Append Polygon and Append Edges commands are for adding additional geometry to an object.

Category: Silo Manual



Arc

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Create > Arc

Description

The Arc command will create an arc or spiral shape at the center of the work grid, based on parameters 

specified in the options window.

Options

Radius

The distance from the center point to the outermost point of the arc.

Inner Radius

The distance from the center point to the innermost point of the arc.

Height

The vertical distance traveled by the arc.

Degrees

The circular distance traveled by the arc.

Sections

The number of sections along the path of the arc.



Notes

Editing values in the options dialog immediately after executing this command will allow you to see 
the effects in real time on the object.

Category: Silo Manual



Arrange UVs In Bounds

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: UVs/Materials > Arrange UVs In Bounds

Description

This command will scale and arrange the selected UVs so that they use as much of the 0-1 UV space as 

possible, while maintaining relative proportions.

Category: Silo Manual



Array

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Create > Array

Description

The Array command requires you to select two objects. An instance of the first object will be created for 

each vertex of the second object, and placed at the position of that vertex. The result is an "array" of 

instances of the first object in the shape of the second object.

Notes

This is a useful way to create many instances of an object at once. See the Instance command for 
more information on instances.
You may wish to use the De-instantiate Instance command to create editable shapes from the 
instances made using the Array command.

Category: Silo Manual



Auto Orient Manipulator

From Nevercenter 3D Modeling Wiki

Default Shortcut: Alt + W (To World)

Menu Path: Selection > Auto Orient Manipulator

Description

The Auto Orient Manipulator submenu allows you set how Silo will orient the manipulator with each new 

selection.

Standard

When checked, this option orients the manipulator differently depending on the selection and the 
manipulator in use. In object selection mode (see Selection Mode), it will orient the manipulator to 
the selected shape's axis. Otherwise the manipulator will be oriented according to world x, y, and z 
axes.

Option

When checked, this option will cause the manipulator to be aligned with the normal vector of the 
selection. In face mode, the normal vector will be the average normal of the faces. In vertex and edge 
selection mode, Silo will attempt to deduce the best normal vector. In object selection mode, this 
command will orient the manipulator to the object's local axis.

To Object

When checked, the manipulator will orient itself to the local axis of the selected shape or the shape 
whose components are selected. If components from multiple shapes are selected, world x, y, and z 
axes will be used.

To World

When checked, the manipulator will orient itself to the world-coordinate x, y, and z axes.

Auto Orienting Off

When this option is checked, the manipulator will not reorient itself on each new selection, but will 
remain as previously oriented.

Enable Repositioning

When this option is checked, the manipulator will reposition itself to the center of the current 
selection. Otherwise it will remain fixed. This option can be very helpful for rotating selections 
around specific axes or points.



Notes

Silo will do its best to determine where the selection's normal ought to be, but in some cases, such as 
with a random non-planar collection of vertices, there is no clear choice.

Category: Silo Manual



Bevel

From Nevercenter 3D Modeling Wiki

Default Shortcut: B

Menu Path: Modify > Bevel

Description

The Bevel tool is used for creating a bevel along selected edges or the edges of selected faces or vertices. It 

is akin to slicing off the corner where two faces meet, revealing a new face and two edges where one used 

to be. It is frequently used, particularly with hard surface modeling, to add a slight rounding effect along 

the corners of an object.

The bevel amount can be controlled interactively using the tool manipulator (or dragging anywhere on the 

screen while the tool manipulator is active) or numerically in the options dialog. Pressing Enter or 

right-clicking will complete and exit the tool.

Options

Default Amount

Determines how much to offset the bevel when the command is called. When used with the tool
already active, it is equivalent to dragging the manipulator handle for this command to the specified 
value, and allows you to enter precise values for the current operation. This amount will also be 
applied each time you use the command in the future. Set it to 0 if you want no default adjustment.

Sticky Functionality

Press and hold the keyboard shortcut for this command to temporarily activate its manipulator, and move 

your mouse (no clicking necessary) to adjust the amount. Release the shortcut key to exit the tool. This 



allows you to model more quickly since you do not need to manually exit the tool.

Context Sensitivity

This command can be applied to faces, edges, vertices, and objects.

Notes

On a subdivided object, bevels can be used to sharpen edges and corners, because it creates 
geometry which is close together. You can see the result interactively by adjusting the bevel amount 
while the shape is subdivided.

Category: Silo Manual



Boolean

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Modify > Boolean > ...

Description

The Booleans submenu contains tools for performing Boolean operations on two objects. Boolean 

operations make a new third object based on the way the volumes of the two selected shapes interact with 

each other. In the Boolean Options window you can choose whether to have Silo delete the original two 

shapes or keep them in the scene.

Intersect

Intersect will create a shape that includes only the volume enclosed by both shapes. (This is often 
described in terms of the shared volume of the two objects.)

Combine



Combine is the inverse of Intersect in that it creates a shape that includes all volume from both 
shapes except that which is enclosed by both shapes simultaneously, thus including the geometry 
which Intersect would remove.

Subtract

Subtract will create a shape that removes the volume of the second object from that of the first 
object.

Options

Delete Originals

When checked, the two selected objects will be deleted after performing the Boolean, leaving only 
the results. Otherwise, all three objects will remain.

Notes

You may wish to perform a Merge Vertices command after performing a Boolean operation to 
merge any vertices that are very close to each other.
If a face from the first shape is perfectly aligned with a face from the second shape (meaning parallel 
to it and intersecting it), the resulting Boolean operation can have unexpected results. The same is 
true if an edge from the first shape is perfectly aligned with an edge from the second shape. To 
perform a good Boolean operation, make sure the geometry isn't aligned in this way.
All the face normals of the involved objects must be pointing outwards for the Boolean operations to 
behave as expected. You may wish to use the Show Normals command to see which direction the 
normal vectors are pointing.

Category: Silo Manual



Break

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + B

Menu Path: Modify > Break

Description

Using the Break command allows you to separate different parts of a single object into separate objects. 

You simply select the faces that you want to break off into their own object and then call the Break 

command.

If you select an entire object, then any separate islands of faces (such as eyeballs not connected to the rest 

of a body) will be broken into separate objects.

Notes

You can also use the Copy and Paste commands to separate geometry from an object, though you 
will need to go back and delete elements of the original object.
Break can be particularly useful when working texture proxies and UV unwrapping.

Category: Silo Manual



Bridge

From Nevercenter 3D Modeling Wiki

Default Shortcut: Shift + B

Menu Path: Modify > Bridge

Description

The Bridge command can be used to connect objects or faces with new geometry. In Face mode, select 

precisely two faces with the same number of edges, and Bridge will create new geometry (basically a 

tunnel) joining the faces. If the faces are from separate objects, the objects will also be merged. In Object 

mode, select two or more objects, and Silo will attempt to bridge the objects in the order they were 

selected, by bridging the two closest faces between each pair of objects.

Notes

Bridge can be used to make windows or other holes in your model by bridging faces on opposite 
sides of the model.
One quick way to block out a character or other shape is to place cubes where you want the joints to 
be, and then bridge the cubes in object mode.

Category: Silo Manual



Brush Editor

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Editors/Options > Brush Editor

Description

The Brush Editor provides access to everything needed for Silo's displacement painting. Most users keep 

this window open whenever they are painting displacement.

Options

Falloff

This editable curve defines how the strength of the brush will be distributed, with the right side 
representing the center of the brush's affected area, and the left side representing the outer edge of 
the radius.

Name

Each brush can be given its own name for easy identification in the brush list.



Radius

Determines how large of an area is affected by the brush. The radius will be represented by a circle 
onscreen whenever a brush is active. The checkbox allows you to specify whether this value is 
affected by pressure sensitivity.

Strength

Determines the strength with which the brush's effect is applied. The strength will be distributed 
according to the falloff curve. The checkbox allows you to specify whether this value is affected by 
pressure sensitivity.

Focus

Determines how far out from the center of a stroke the falloff will begin to be applied. With a value 
of 0, the falloff will look exactly like the falloff curve. With a value of 0.5, the brush will be applied 
at full strength until halfway out from the center, at which point it will begin to follow the falloff 
curve. The checkbox allows you to specify whether this value is affected by pressure sensitivity.

Image

Instead of a falloff curve, the strength of the brush can be distributed according to a reference image. 
For example, an image of bark could be used in conjunction with Push/Pull to paint bark-like details 
on your model. Silo only uses lightness and darkness values, so the brighter parts of the image will 
correspond to a stronger effect of the brush.

Operation

Here you can specify what sort of effect this brush will have on the model. Normally, artists will 
create multiple brushes and select an effect for each one, rather than using one brush and changing 
this value frequently. Effect names with a slash (such as Push/Pull) have an alternate effect which 
can be accessed by right clicking when using the brush.

Size To

The difference between these two options is most easily seen by zooming in and out with a brush 
active. The Screen option will keep the brush the same size in relation to the screen, while the World 
option will keep the brush the same size in relation to the model.

Brush Thumbnails

Below the brush options, you will see thumbnails of all the brushes currently available. Click on a 
brush to set it as the active brush and change its properties. You can right click on these thumbnails 
for additional options, including removing a brush from the palette, creating a new brush, and 
duplicating the selected brush (which will make a new brush with copied settings).

Notes

See Paint Displacement for more information on displacement painting.



Category: Silo Manual



Button Page 1-9

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: None

Description

You can assign the Button Page functions to keyboard shortcuts, image buttons, or mouse buttons using 

their respective editors. These functions will skip to their respective button pages. See Button Settings for 

more information about button pages and image buttons in Silo.

Notes

If, for example, there aren't four button pages, then the Button Page 4 command will do nothing.
These commands do not appear anywhere in Silo's menu system. They must be assigned to
keyboard shortcuts, mouse clicks, or image buttons.

Category: Silo Manual



Button Settings

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Editors/Options > Button Settings

Description

The Button Settings dialog allows you to customize Silo's on-screen buttons. Buttons are arranged in a 

series of "button pages", where each page represents a set of buttons which is on-screen at a given time. 

You can switch between these pages using various commands in Silo, or create buttons for those 

commands to allow switching from within your custom interface. There are also commands to completely 

hide or temporarily show the button pages, leading many interface designers to put buttons right in the 

middle of the screen and keep them hidden most of the time. The editor is designed to maximize 

customization, but also offers automatic alignment and default images if you just want to quickly add some 

buttons.

Any image can be imported and used as a button, with full support for transparency (using the png image 

format), offering a lot of freedom for custom designs. Each function also has a provided default image if 

you do not want to design your own.



Each button page is composed of a list of buttons. Choosing the value for Anchor To for each button or 

button page determines where each button will be aligned with respect to. For example, any buttons which

are anchored to Auto Left will align themselves in a column on the left of the screen. In addition, each

button can be assigned any image for its up and down states. This setup offers a large amount of control 

over the look and functionality of Silo.

The button pages are displayed in a tree-like structure. To add a button page or add a button to the current 

button page, use the Add Button and Add Page buttons. Use the up and down arrow buttons next to the 

Add buttons to move the current button or page up and down in the list. To edit the properties of a specific 

button or page, select it. To rename a page, double click on it. To delete a button or page, select it and use 

the Delete key.

Page Options

Anchor To

Specifying an Anchor To option when a page is selected will assign that setting to all buttons in the 
page.

Persistent

You may have interface elements which you want to be displayed regardless of which button page is 
currently shown (e.g. for a custom menu bar). Setting a button page to Persistent will cause it to be 
shown even as you cycle through others.

Options

Allow Dragging

For any button which allows you to specify X and Y values, you will be able to move it by clicking 
and dragging on it in the main Silo window.

Command

Here you can choose what function you want the button to perform. Note that there is a "No 
Function" in the command list, in case you want to add an interface element that shouldn't do 
anything when clicked.

Up Image

The main image for the button.

Down Image

If you like, you can specify an alternate image to display when a button is being clicked. For some 
commands, this image will be displayed while the command is activated. If you do not specify an 
image, the Up Image will be used.

Anchor To



Buttons can be anchored to different areas of the screen. Options beginning with "Auto" will 
automatically separate and space all of the buttons anchored to that section. So adding several 
buttons and setting them to "Auto Left" will cause them to be arranged in a list on the left side of the 
screen.

Options without "Auto" will place all buttons at the exact location specified. So adding several 
buttons and setting them to "Middle Left" will place them all directly on top of each other. You can 
then specify offsets from that location using the following two settings. If you are creating a custom 
interface with your own images, you may wish to use this option to more precisely align your 
buttons.

Position XY

For buttons which are not automatically placed, you can specify an offset in pixels from the anchor 
position.

Anchor % XY

For buttons which are anchored to Custom, you can specify the anchor location on the screen based 
on percentages. (So using 50% for both values would be the same as anchoring to Center, for 
example.) The Position XY values will then be used to offset from that point.

Notes

Some users may wish to create a blank button page which can be cycled to, avoiding the need to 
toggle display of button pages on and off.
This dialog uses Presets. You can add your own preset by copying a Silo preferences (.sip) file into 
the corresponding presets directory within the Silo install directory on your computer.
When trading setups, be sure to include the image files for the buttons in a folder with the .sip file.

Category: Silo Manual
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Calculate Symmetry

From Nevercenter 3D Modeling Wiki

Default Shortcut: N

Menu Path: Modify > Mirroring > Calculate Symmetry

Description

The Calculate Symmetry command will attempt to find symmetrical components on an object by looking 

for vertices which should be mirrors of each other topologically, based on a central seam. If a single edge 

is selected when this function is called, the mirror seam will be determined by that edge. If there is no 

selection or anything other than a single edge is selected, the mirror seam will be determined automatically 

based on the axis selected in the options. Symmetry will also be enabled for the object (see Symmetry 

Mode Toggle).

Once symmetry has been calculated and as long as it is enabled, edits made to one side of the model will be 

reflected in the other side. Unlike with instance mirroring (see Instance Mirror Toggle), you can edit either 

side (or both sides at once) of the mesh. The shape will also subdivide properly and displacement painting 

will be mirrored as well. Newly created geometry added via commands such as Bevel and Extrude should 

also be mirrored properly automatically.

Note that this command will not immediately move any geometry to make it visually symmetrical, (for that, 

use Restore Symmetry after calculating symmetry, or use Mirror Geometry) but future geometry edits will 

move affected geometry to make it symmetrical. This means that you can leave portions of your model 

asymmetrical even while you are working with symmetry. Just don't edit those parts while symmetry is 

enabled.

Options

Symmetry Axis

Choose the axis along which the symmetry will be performed. Note that this command uses the 
object's local axis, which means the object does not need to be in the center of the scene for 
symmetry to be calculated properly. (You may wish to use Recenter Object Axis to ensure the 
object's axis is in the proper location relative to its geometry.)

Tolerance

Vertices which are within this distance from the center of the mirror plane will be marked as though 
they are on the mirror seam. If some vertices are not being properly detected as along the mirror 
seam, you may need to increase this tolerance or adjust their position before calling Calculate 
Symmetry.



Circle

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Create > Circle

Description

The Circle command will create a circle shape at the center of the work grid, based on parameters specified 

in the options window.

Options

Radius

The radius (distance out from the y-axis on the xz-plane).

Sections

The number of sections around the outside of the shape (radial sections).

Fill

Toggle disc or empty circle.

Spokes

Toggle spokes on/off (only available for filled circle).

Notes



Editing values in the options dialog immediately after executing this command will allow you to see 
the effects in real time on the object.

Category: Silo Manual



Clear Higher Subdivision

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Subdivision > Clear Higher Subdivision

Description

When using displacement painting (see Paint Displacement), data is stored for each subdivision level at 

which you have painted. If you wish to remove higher levels of subdivision from your object, either to 

save memory or to remove displacement painting on that level, unsubdivide to the next lower level and use 

the Clear Higher Subdivision command to remove all higher subdivision information from your model.

Notes

If you find your models are loading at a high subdivision level, they may have displacement data 
without you realizing it. Clearing higher subdivision will allow you to load them at a lower 
resolution.

Category: Silo Manual



Color Settings

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Editors/Options > Color Settings

Description

The Color Settings dialog allows you to customize the color of nearly all elements in Silo. Select a scene 

item from the list, and then click on the color bar below it to edit that color. All changes will be represented 

in the scene as they are made. Click OK when you are satisfied or Cancel to return to the color settings 

which were in place when you opened the dialog. You can also save and load colors schemes, and share 

them with others.

Notes

Color settings will automatically be remembered when you close the program, so your changes will 
last until you edit the colors again.
One of the few things you can't change here is the default material color, which is instead changed in 
the Material Editor. The default material color will be exported and loaded when you load and save



from this dialog.
This dialog uses Presets. You can add your own preset by copying a Silo preferences (.sip) file into 
the corresponding presets directory within the Silo install directory on your computer.

Category: Silo Manual



Combine Objects

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Create > Combine Objects

Description

The Combine Objects command makes all selected objects into a single object.

Notes

Combine Objects is particularly useful for operations such as booleans or the Append Polygon Tool 
(see Append) which require that a specific number of objects be selected, since you can merge 
several objects to make one object.
The Merge command, when called in object selection mode, will behave the same as this command.
You can separate objects again by selecting all faces of one object and using the Break command.
If you want to be able to select your objects as one, but have them remain as separate objects, you 
may prefer to Group them (see Group Selection).

Category: Silo Manual



Cone

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Create > Cone

Description

The Cone command will create a cone shape at the center of the work grid, based on parameters specified 

in the options window.

Options

Top Radius

The radius (distance out from the y-axis on the xz-plane) of the top of the cone.

Bottom Radius

The radius (distance out from the y-axis on the xz-plane) of the bottom of the cone.

Height

The height (y-axis).

Sections

The number of sections around the outside of the shape (radial sections).

Height Sections

The number of vertical sections (along the y-axis).



Spokes

Toggle spokes on/off.

Notes

Editing values in the options dialog immediately after executing this command will allow you to see 
the effects in real time on the object.

Category: Silo Manual



Constrain

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: None

Description

The Constrain commands allow you to work in Silo without using the manipulators. If, for example, you

had Constrain to X Axis assigned to the F1 key, then pressing F1 and dragging your mouse would be 

equivalent to clicking with your mouse on the manipulator's x-axis handle and dragging.

Notes

These commands do not appear anywhere in Silo's menu system. They must be assigned to
keyboard shortcuts, mouse clicks, or image buttons.

Category: Silo Manual



Context Help

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Help > Context Help

Description

This window will display brief help comments for commands as they are called or moused over in the 

menus. It may be useful to keep this window open as you are learning Silo.

Notes

This window may be useful in conjunction with the Tutorials window.

Category: Silo Manual



Convert Selection To

From Nevercenter 3D Modeling Wiki

Default Shortcut: Shift + A, Shift + S, Shift + D

Menu Path: Selection > Convert Selection To

Description

The Convert Selection To submenu allows you to switch between component (vertex, edge, and face) 

selection modes while retaining the current selection. Only components of the new selection mode which

had all of their elements selected in the old mode will be selected. For example, all vertices of a face must 

be selected in Vertex mode in order for it to be selected when you convert to Face mode. For a more 

detailed explanation of the various selection modes, see the Selection Mode submenu.

Vertices

Converts the selection into vertices. All vertices of selected objects, faces, or edges will become
selected.

Edges

Converts the selection into edges. All edges with both of their vertices included in the current
selection will become selected.

Faces

Converts the selection into faces. All faces with all of their vertices included in the current selection
will become selected.

Notes

Some prefer this mode of converting selection to the default mode of switching selections which 
does not maintain the selection.
Although you cannot convert a selection to Object mode, you can convert a selection from Object 
mode to any of the other modes, which will select all of that object's components.



Category: Silo Manual



Copy

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + C

Menu Path: Edit > Copy

Description

The Copy command will copy whatever shapes, faces, edges, or vertices you have currently selected to the 

clipboard. You can then use the Paste command to create a new shape that has the same structure as that 

which you copied to the clipboard. You could, for example, copy a sequence of edges from one shape, 

paste them to make a new shape, and then use that new shape as a path for a Path Extrusion Object to 

make an extrusion that exactly follows the contours of the original shape.

Notes

Also see Paste.

Category: Silo Manual



Crease Edges

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Subdivision > Crease Edges

Description

The Crease Edges command allows you to change the way an object is subdivided. Creasing an edge 

lessens the smoothing effect of the subdivision algorithm for that edge, resulting in a creased or hardened 

line on the subdivided object.

In terms of the subdivision algorithm, a crease causes the vertices of that edge to be less displaced, i.e. less 

smoothed, than they would otherwise be. Creased edges have a cumulative effect on the vertices they 

share, so a vertex with three or more attached edges creased will be in the same place on the subdivided 

shape as it was on the control mesh, while a vertex with none of its edges creased will be smoothed 

normally. Experiment with this command to learn how to use it effectively.

Notes

A crease can be removed from an edge with the Uncrease Edges command.
Crease Edge only works in edge selection mode. (See Selection Mode.)

Category: Silo Manual



Cube

From Nevercenter 3D Modeling Wiki

Default Shortcut: Alt + C

Menu Path: Create > Cube

Description

The Cube command will create a cube shape at the center of the work grid, based on parameters specified 

in the options window.

Options

Width

The width (x-axis thickness) of the cube to be created.

Height

The height (y-axis thickness) of the cube to be created.

Depth

The depth (z-axis thickness) of the cube to be created.

Width Sections

The number of sections along the cube's x-axis.

Height Sections

The number of sections along the cube's y-axis.



Depth Sections

The number of sections along the cube's z-axis.

Notes

Editing values in the options dialog immediately after executing this command will allow you to see 
the effects in real time on the object.

Category: Silo Manual



Custom Primitive

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Create > Custom Primitive

Description

The Custom Primitive menu mirrors the "Primitives" folder in the Silo program folder on the user's hard 

drive. Any files placed in that folder will be easily accessible from within Silo via this menu. Several 

custom primitives are shipped with Silo, including base character models and useful lighting setups, but 

users may wish to augment these with their own commonly-used files. Files loaded from this menu will be 

loaded into the current scene.

Notes

Anything in a scene, including elements other than objects, that can be saved out can be used as a 
custom primitive. Examples include custom lighting setups, materials, and textured panels for 
applying reference images.

The menu does not display sub-folders, so all content must be placed directly in the Primitives 
folder.

Category: Silo Manual



Cut

From Nevercenter 3D Modeling Wiki

Default Shortcut: X

Menu Path: Modify > Cut

Description

Cut is a frequently used command for adding detail to geometry by cutting polygons with new edges. If 

components are already selected, it will attempt to cut in new edges across that selection. Otherwise an 

interactive tool will be entered which allows you to draw your cut on the model.

Cut Command

When vertices, edges, or faces are selected and Cut is called, it will behave as a command rather than an 

interactive tool, with the following results:

Vertex Selection

With a vertex selection, Cut will connect any selected vertices that share a face, splitting that face 
with a new edge.

Edge Selection

With an edge selection, Cut will divide each edge with a new vertex and split any polygons 
containing more than one of the selected edges by connecting the newly created vertices.

Face Selection

With a face selection, if a face loop is selected then Cut will divide the face loop.

The common usage of Cut for any component selection mode is to "draw" out a path for a new edge by 

selecting existing vertices, edges, or faces, and then use the command to make a cut which follows that 



selection.

Cut Tool

The Cut Tool is enabled when Cut is called with no components selected (objects can be selected,

however). To use the Cut Tool, click and drag the mouse on a valid face or edge to add and position a new 

vertex, and start a string of edges. Keep clicking and dragging to add additional vertices connected by 

edges.

Note that a cut cannot jump across an edge between two faces, so in order to make a continuous cut across 

multiple faces you must use the tool to cut a new vertex into each edge as you cross it. You can add as 

many edges as you like within each face.

If you click in empty space off your model, you can drag to draw a line across the model. Releasing the

mouse will cut all faces and edges that cross the drawn line, using the drawn line as a cutting plane.

Add Points: Left Mouse Button

Click with the left mouse button to add new points to your cut. You can click on edges, vertices, or
anywhere on the interior of faces.

Remove Points: Delete

Remove points from your current cut.

Exit: Esc

Exit the tool.

Sticky Functionality

If you press and hold the keyboard shortcut for Cut in a context where the Cut Tool is activated, the tool 

will exit automatically when the key is released. This is the optimal method for quickly adding a cut while 

modeling.

Options

Cut Sections

If this value is greater than 1, that number of parallel, evenly-spaced cuts will be performed with 
each call to the Cut command on edge selections.

Also Known As

Cut combines two commonly-used functions from Silo version 1, Connect and the Split Tool. In other 

applications, these tools are also known as Slice, Knife, and Divide.

krause thilo
Kommentar zu Text
2 kanten wählen-danh cut mit z.b. 10 sektionen erzeugt 10 parallele linien

bei vorauswahl einer kante werden 10 segmente erzeugt



Category: Silo Manual



Cycle Shading

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: None

Description

These commands, Cycle Shading Forward and Cycle Shading Reverse, are used to cycle the shading mode 

of selected objects between flat, smooth, fast shade, and wire frame modes. This function allows you to

access all shading modes with one command.

Notes

These commands do not appear anywhere in Silo's menu system. They must be assigned to
keyboard shortcuts, mouse clicks, or image buttons.

Category: Silo Manual



Cylinder

From Nevercenter 3D Modeling Wiki

Default Shortcut: Alt + Y

Menu Path: Create > Cylinder

Description

The Cylinder command will create a cylinder shape at the center of the work grid, based on parameters 

specified in the options window.

Options

Radius

The radius from the y-axis on the xz-plane of the shape.

Height

The height along the y-axis of the shape.

Sections

The number of radial sections around the shape.

Height Sections

The number of vertical sections along the y-axis of the shape.

Spokes

If this option is enabled, the top and bottom faces of the cylinder will be divided into spokes.



Notes

Editing values in the options dialog immediately after executing this command will allow you to see 
the effects in real time on the object.

Category: Silo Manual



De-instantiate Instance

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + Shift + I

Menu Path: Create > De-instantiate Instance

Description

The De-instantiate Instance command allows you turn an instance of an object into a regular, editable

object. An instance of an object is a copy that updates automatically with every edit made to the source 

object, and is not editable in vertex, edge, or face modes itself. A de-instantiated instance no longer has any 

connection to its source object.

Notes

See also the Create Instance command to learn more about instances.
De-instantiate Instance only works in object selection mode with one or more instances selected.
(See Selection Mode.)

Category: Silo Manual



Delete Viewport Image

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Display > Delete Viewport Image

Description

The Delete Viewport Image command will remove the background image, if any, in the current viewport.

Notes

For more information on viewport images, see Set Viewport Image.

Category: Silo Manual



Delete

From Nevercenter 3D Modeling Wiki

Default Shortcut: Delete

Menu Path: Edit > Delete

Description

The Delete command does its best to delete whatever geometry you have selected. Different types of 

geometry can or cannot be deleted depending on the geometry type and the way the geometry is attached to 

other geometry.

Category: Silo Manual



Deselect Inactive

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Selection > Deselect Inactive

Description

The Deselect Inactive command will deselect all objects which are currently selectable but have no 

components selected. For example, if a cube's vertices are selectable (i.e. the cube was selected in object 

selection mode, then taken into vertex selection mode), but none of the vertices are selected, then that cube 

is an inactive object. This command allows you to narrow the selected (i.e. editable) objects to those you 

are currently working on.

Notes

Deselect Inactive has no effect in object selection mode.
This command has the same effect as switching to object selection mode, deselecting the objects you 
want to make uneditable, and returning to the current Selection Mode.

Category: Silo Manual



Deselect

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Selection > Deselect

Description

The Deselect command will deselect all objects, faces, edges, or vertices which are currently selected, 

based on the current selection mode.

Notes

If you use this command often, you may want to assign it to a mouse button/modifier combination in 
the Mouse Settings window.
To change whether or not the faces, edges, or vertices of an object are selectable, either select or 
deselect that object in object selection mode (see Selection Mode) before changing to the appropriate 
component selection mode.

Category: Silo Manual



Display Settings

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Editors/Options > Display Settings

Description

The Display Settings dialog allows you to edit many options related to the look and feel of Silo.

Options

Edge Width

This field allows you to change the width in pixels of all unselected geometry lines. This will not 
affect the manipulator or grid lines.

Vertex Size



This field allows you to change the size in pixels of all unselected vertices.

Selected Edge Width

You can adjust the size of selected edges. You may wish to make them a little larger for visibility 
purposes.

Selected Vertex Size

You can adjust the size of selected vertices. You may wish to make them a little larger for visibility 
purposes.

Edge Alpha

This value determines how much the edge blends with the object's material.

Face Alpha

This value determines how much face selections and highlighting blend with the object's material.

Normals Length

When normals are displayed, they are displayed at a fixed length. This field allows you to change 
that length.

Camera Field of View

The perspective camera's field of view is the angle, in degrees, which determines how much of the 
scene the camera can see at once. Large angles will result in a "fish-eye" effect.

Near Clipping Plane

The near clipping distance is the distance from the camera which geometry has to be in order for it to 
be displayed in the viewport. This is generally a very small value, but needs to be greater than 0 for 
the display to function properly. adjusting this value may correct some display errors.

Far Clipping Plane

The far clipping distance is the distance from the camera at which an object ceases to be displayed. 
In a large scene, this can speed up performance by not displaying irrelevant geometry.

Walkthrough Mode Speed

In Walkthrough Mode, you may find that the camera zooms and pans at an undesirable speed. This 
field allows you to change the speed.

Work Grid Width

This field allows you to change the overall width of the grid. This value refers to the distance from 
the origin to each side of the grid. (So a grid with width 10m will be 10m in the positive X direction 
as well as 10m in the negative X direction.)



Work Grid Spacing

This field allows you to change the spacing between grid lines. This change affects all work grids 
except for those in the texture views.

Work Grid Heavy Step

This field allows you to set how many lines of the grid to skip before making a thick line. This 
allows you to, for example, have the grid spacing set at 1 inch and set the heavy line spacing to 12 
so that every foot (i.e. every 12 inches) is marked with a heavy line while inches are marked with a 
lighter line.

Work Grid Alpha

You can change the degree to which the work grid blends in with the background.

Texture Grid Spacing

The same as regular work grid spacing, but for the texture views.

Texture Grid Alpha

The same as regular work grid alpha, but for the texture views.

Texture Resolution

Textures will be displayed at this resolution in Silo. Use a smaller value for faster response time, and 
a larger value for better display quality with textures.

Optimized Face Draw Limit

If your model has more faces than this number, Silo will employ special techniques to help speed up 
the display and interactivity, though it may decrease display accuracy. The main technique is to 
automatically unsubdivide the model one level as you rotate or interact with it.

Rotate Camera Around

By default, Silo will use your most recent selection to determine the center of view rotation. If you 
prefer to have more control, you can set this value to Framed Selection. And then use the Frame 
Selection or Focus Selection commands to specify a rotation center.

Backface Culling

If this box is checked, OpenGL won't draw polygons that are facing away from you (that is, their 
normal vector is pointing into the screen rather than out towards you). This can result in speed 
increases, but sometimes polygons will not be visible which would otherwise be.

Show Subdivision Cages

If this box is checked, the outer cage of a subdivided shape will always show. If it is unchecked, 
you will only see the subdivided shape in every mode except for object selection mode, and you can 
make your selection and edits directly from the subdivided surface (the "iso surface").



Show Selection Subdivision Cages

If this option is checked and Show Subdivision Cages is unchecked, on subdivided shapes you will 
only see the portion of the control cage which is currently selected (i.e. the particular edges, faces, or 
vertices that are currently selected). This helps to see the actual position of the geometry you are 
editing while subdivided.

Show Selection Highlighting

Silo's selection highlighting will show you a preview of which elements (if any) would be selected if 
you made a selection at the current mouse position. So hovering the mouse over a face in face 
selection mode will cause that face to be highlighted, for example. Some commands allow you to 
work with selection highlighting, so you can skip the step of actually selecting elements. To disable 
selection highlighting, uncheck this option.

Triangulate Quads

OpenGL automatically triangulates any faces with five or more sides purely for display purposes. 
(You cannot access or edit these invisible added edges, and they do not affect geometry modification 
or output in any way.) This setting causes the same to happen with four-sided faces. If you are 
noticing display errors with non-planar four-sided faces, try this setting.

Notes

Other ways to change the look of the program include editing the colors in the Color Settings dialog 
and editing the image buttons in the Button Settings dialog.

Category: Silo Manual



Duplicate

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + D

Menu Path: Create > Duplicate

Description

The Duplicate command allows you to create a copy of the currently selected objects. The copy will be 

placed in the same location as the original and will be selected, allowing you to easily move it.

Notes

This is the same as using the copy and paste commands on an object.
Unlike an Instance, the copy is entirely independent of the original object once it has been created.
Duplicate only works in object selection mode. (See Selection Mode.)

Category: Silo Manual



Edge Tool

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Create > Edge Tool

Description

The Edge Tool command will initialize an edge creation tool. Use this tool by clicking and dragging to add 

successive points to the line segment and position them. You can make a closed loop by clicking on the 

first point of the line segment, after which the tool will end. If you do not want to make a closed line 

segment, press Enter, Esc, or right-click to finish off the line segment and again to exit the tool.

When creating a line segment with this tool, the second and third point you create will be placed at the 

same distance from the camera as the first point; the fourth point and every point thereafter will be placed 

in the same plane as the previous three points. For example, to place a line segment in the work plane, you

would use the tool from the top orthographic view.

If you have an object selected and enter this tool, you can append edges to the existing object by clicking 

on the vertices of the object with the tool. Otherwise a new shape will be created with the edges you draw

out.

Line segments can be used as paths or profiles in Path Extrusion Objects, Extrusion Objects, and Lathe 

Objects. If you subdivide the line segment, the subdivided shape will be used for the Create Path 

Extrusion, Create Extrusion Shape, and Create Lathe commands.

Options

Subsegments

The number of sub-segments per segment drawn.



Notes

You can subdivide a line segment just as you would subdivide any other shape in Silo (using the 
Subdivide and Unsubdivide commands).
A line segment in Silo is really just a sequence of regular edges, i.e. a line segment is just a regular 
shape which contains only edges. This means that you can copy the edges from any shape and paste 
them to make a line segment that can be used for extrusions or lathes.
Calling the Edge Tool when an object is already selected is the same as activating the Append Edges
tool.

Category: Silo Manual



Exit

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: File > Exit

Description

Exit the program. You will be prompted to save any unsaved changes.

Category: Silo Manual



Expand Selection

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Selection > Expand Selection

Description

The Expand Selection command will expand the current selection to all contiguous elements. For example, 

if sphere has been cut into two separate halves, and one vertex is selected on one half of the sphere, then 

Expand Selection will select all the vertices of that half of the sphere. Even if the entire sphere is one 

object, only that half will be selected.

Notes

Expand Selection has no effect in object selection mode.
This command can be particularly useful when working with separate pieces of a single object. To 
break pieces of an object into separate objects, Copy each piece and Paste it as a new object.

Category: Silo Manual



Export UVs To Image

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: UVs/Materials > Export UVs to Image

Description

This command will export an image of the selected UVs, useful as a reference for texture painting. Images 

can be exported to any of Silo's supported image formats.

Options

Image Width

Width of the output image.

Image Height

Height of output image.

Background Color

Background color of output image.

Line Color

Color used to draw the lines of the image.

Notes

You can select components (faces, edges, or vertices) to export an image of only those components.
Square output dimensions are recommended to avoid distortion.

Category: Silo Manual



Extrude

From Nevercenter 3D Modeling Wiki

Default Shortcut: Z

Menu Path: Modify > Extrude

Description

The Extrude command is an effective way of adding new geometry to an object by essentially pulling or 

extending faces or edges out of the model. In edge selection mode, Extrude creates a new copy of the 

selected edges, and connects each new edge to the original with a face. The new edge will then be selected, 

allowing you to move or otherwise edit it as desired. In face selection mode, new faces are similarly 

created for the boundaries of the selection, allowing you to pull out the selected faces from the original 

object.

The extrude amount can be controlled interactively using the tool manipulator or numerically in the options 

dialog. Pressing Enter or right-clicking will complete and exit the tool.

Options

Default Amount

Determines how much to offset the extrude when the command is called. When used with the tool
already active, it is equivalent to dragging the manipulator handle for this command to the specified 
value, and allows you to enter precise values for the current operation. This amount will also be 
applied each time you use the command in the future. Set it to 0 if you want no default adjustment.

Extrude Faces Together

If this option is checked, selected faces which are neighbors will be extruded as a whole, rather than 
individually.



Sticky Functionality

Press and hold the keyboard shortcut for this command to temporarily enter the tool, and move your 

mouse to adjust the amount. Release the shortcut to exit the tool. This allows you to model more quickly 

since you do not need to manually exit the tool.

Category: Silo Manual
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Extrusion Object

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Create > Extrusion Object

Description

The Extrusion Object command will extrude a surface along an axis to create a 3-dimensional shape.

Options

Height

The amount of extrusion.

Sections

The extrusion will be divided into this many sections.

Axis

The axis along which the extrusion is performed.

Notes

Extrusion Object will work on a 3-dimensional shape such as a cube, but usually should be used on 
relatively flat non-closed shapes such as a polygons, line segments or grids.
Extruding an object that consists of faces will create a closed object (caps on the end), whereas 
extruding an object that consists of only edges (e.g. a line segment) will create an object that is open 
on the ends.



File Format Settings

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: File > File Format Settings

Description

The File Format Settings dialog allows you to adjust settings specific to each of Silo's import and export 

formats. Choosing the desired file format from the drop-down list will bring up the available settings for 

that format. Possible settings include the following.

Import Scale Factor and Export Scale Factor

If files imported from the selected file type are too small in Silo, you can specify a scale factor which 
will always be applied when importing from this file type. You will probably want to specify a 
corresponding Export Scale Factor, for example an import factor of 2 and an export factor of .5, so 
that your object will be returned to its original size on export.

Import UVs and Export UVs

Importing and exporting UVs can sometimes cause problems between applications. If UVs are 
unnecessary, or you have a file which is not loading properly, you may wish to try disabling the 
importing or exporting of UVs.

Import Groups as Objects and Export Groups as Objects

This setting is specific to the .obj format, and relates to two different methods various applications 
use for importing the same data. If you load or export an .obj file and experience strange results such 
as an object broken into many pieces or the loss of specified groups, you may wish to experiment 
with these settings.

Render Width and Render Height

For render formats such as .rib and .pov that allow you to specify the size of the output image when 
they are rendered.

Header File

For certain export formats, this will allow you to specify a file whose contents will be copied to the 
top of the output file, immediately preceding the scene information written by the program.

Footer File

For certain export formats, this will allow you to specify a file whose contents will be copied to the 



bottom of the output file, immediately following the scene information written by the program.

Include Lights

For certain export formats that include lighting information, you can check this box to have that 
information included in the output file or not. An example of when you might want to leave this item 
unchecked is when you've set up specialized lighting in an included header file which you want to 
use instead of the scene's lighting.

Include Camera

As with the Include Lights option, you can check this box to have camera information included in 
the output file or not, for certain file formats which allow for camera information. An example of 
when you might want to leave this item unchecked is when you've set up a specialized camera in an 
included header file which you want to use instead of the scene's camera.

Include Materials

Choose whether or not to include materials in the output file for certain format types.

Notes

Not all options will apply to all export formats, even if those formats could support those options.
See Supported 3D File Formats.

Category: Silo Manual



Fill Hole

From Nevercenter 3D Modeling Wiki

Default Shortcut: Shift + F

Menu Path: Modify > Fill Hole

Description

The Fill Hole command can be used to cap or fill a hole in your mesh with a single new polygon. To use it, 

select exactly one edge along the border of a hole, and call the command.

Notes

This is akin to selecting all of the vertices around a hole and using Append Polygon.

Category: Silo Manual



Flatten

From Nevercenter 3D Modeling Wiki

Default Shortcut: Alt + Shift + F

Menu Path: Modify > Flatten

Description

The Flatten command will take whatever your selection is and scale it by a factor of zero in the direction 

specified in the flatten options dialog.

Options

Axis

The axis along which the selection will be flattened. You can choose the local (manipulator) x, y, or
z axis, the world-coordinate x, y, or z axis, or the selection's normal vector. For example, if you have 
a face that is non-planar and you want to make it planar, you can select it with the manipulator set to 
orient itself to the face normal (see Auto Orient Manipulator), and then call Flatten with the options 
set to flatten along the local y axis.

Notes

Flatten will work on instances.



Category: Silo Manual



Flip UVs

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: UVs/Materials > Flip UVs

Description

The flip UVs command will flip selected UVs horizontally.

Category: Silo Manual



Focus Selection

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Display > Focus Selection

Description

The Focus Selection command will center the current selection in the active viewport. This is useful for 

times when you may have rotated the camera to a position where you cannot find the object you're working 

on, or to quickly center a new selection in the viewport.

If you have chosen to use Framed Selection for the View Rotation Center setting in the General Settings

window, then a call to Focus Selection will cause the center of the view rotation to be updated to the 

position of the manipulator on the current selection, where it will stay until a subsequent call to Focus 

Selection or Frame Selection is made.

Notes

If you have chosen Manipulator for the View Rotation Center setting in the General Settings
window, calling Focus Selection will have no effect on the center of the view rotation.
See also Frame Selection, which will center the selection and also zoom so that the selection fills the 
viewport.

Category: Silo Manual



Frame Selection

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Display > Frame Selection

Description

The Frame Selection command will both center the current selection and zoom the camera so that the 

selection fills the active viewport. This is useful for times when you may have rotated the camera to a

position where you cannot find the object you're working on, or to quickly center a new selection in the 

viewport.

If you have chosen to use Framed Selection for the View Rotation Center setting in the General Settings

window, then a call to Frame Selection will cause the center of the view rotation to be updated to the 

position of the manipulator on the current selection, where it will stay until a subsequent call to Frame 

Selection or Focus Selection is made.

Notes

If you have chosen Manipulator for the View Rotation Center setting in the General Settings
window, calling Frame Selection will have no effect on the center of the view rotation.
See also Focus Selection, which will center the selection but not zoom.

Category: Silo Manual



General Settings

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Editors/Options > General Settings

Description

The General Settings dialog allows you to change options which affect the operation of the program in 

general.

Options

Open Windows

Here you can specify where newly-opened dialogs and other interface windows will first appear on 
the screen, and whether they will be docked or undocked.

Minutes to Autosave

This allows you to set the time interval between saves for backing up your work. Silo stores the 10 
latest autosaves in a directory called "Autosaves" in the Silo folder on your hard drive. Set this value 
to 0 to disable autosaves.

Undo Level

Silo will keep track of this number of previous geometry edits. You can go back and forth between 
them using the Undo and Redo commands.

Selection Radius

This determines how many pixels away from a component your mouse can be and still highlight or 
select it. Some people prefer a higher selection radius so that they can work quickly and do not have 
to be as accurate with their mouse.



Manipulator Sensitivity

Similar to the Selection Radius, this value determines how far in pixels from a manipulator handle 
your mouse can be and still select it. Use a large value if you feel you have to be too precise when 
grabbing handles, and a smaller value if the manipulator is getting in the way of other selections.

Units

Silo can operate in either the English (feet and inches) or Metric systems, or can use a generic 
system without any direct real-world correlation. This will update all unit-related fields in all 
dialogues, as well as the scene's representation.

Unit Scale

This value adjusts the relative size of the units without changing the scene geometry. If, for example, 
you wanted a box that was 1m square to represent a box that was 2m square, you would change this 
value from 1 to .5, and then all fields would show that the box was now 2m square.

Notes

Many of the options offered in the General Settings dialogue relate to system performance. 
Experimentation may be the best way of determining how to get the most out of your particular 
setup.

Category: Silo Manual



Generate Displacement Map

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: UVs/Materials > Generate Displacement Map

Description

Generate Displacement Map will output a displacement map from a subdivided object to its base mesh, or 

from one or more objects to another object. These displacement maps can then be used by an external 

renderer to recreate the details of the geometry they were generated from, and can be a great way to export 

high-poly detail such as displacement painting or mechanical details to a renderer or game engine.

Options

Width and Height

Specify the dimensions of the normal map you wish to output.

Raycast Samples

When raycasting to determine normals, more raycast samples will result in a more accurate rendition, 
but will take longer to calculate.

Raycast Distance

Use this value to specify how far rays are cast. This distance should be large enough to span the gap 
between your target surface and the surfaces from which it should be finding normals, but small 
enough that you do not accidentally get data from other nearby surfaces.

Notes

Silo does not currently support 32-bit displacement maps.
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Generate Normal Map

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: UVs/Materials > Generate Normal Map

Description

Generate Normal Map will output a normal map from a subdivided object to its base mesh, or from one or 

more objects to another object. These normal maps can then be used by an external renderer to recreate the 

details of the geometry they were generated from, and can be a great way to export high-poly detail such as 

displacement painting or mechanical details to a renderer or game engine.

Options

Width and Height

Specify the dimensions of the normal map you wish to output.

Coordinate Space

With world coordinate space, normals are output with respect to the world x, y, and z axes. With 
Tanget coordinate space, normals are output with respect to each face's orientation. The second 
option is particularly useful for normal maps on animated models. Check your renderer or game 
engine documentation to determine which method(s) it supports.

RGB Order

R(red) G(green) and B(blue) refers to which color value is written out first. The order is generally 
RGB, but your renderer or game engine may require a different order.

Invert Red, Invert Green, and Invert Blue

You may need to invert one or more of the channels depending on your renderer or game engine.

Raycast Samples

When raycasting to determine normals, more raycast samples will result in a more accurate rendition, 
but will take longer to calculate.

Raycast Distance

Use this value to specify how far rays are cast. This distance should be large enough to span the gap 
between your target surface and the surfaces from which it should be finding normals, but small 
enough that you do not accidentally get data from other nearby surfaces.



Raycast Self

If you are extracting normals from a single object's subdivided shape to its base shape (most likely 
after painting displacement on that object), then Silo can perform a much faster calculation which 
does not involve raycasting. You can use this command to force raycasting, which may be more 
accurate.
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Grid

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Create > Grid

Description

The Grid command will create a grid shape at the center of the work grid, based on parameters specified in 

the options window.

Options

Width

The width (x-axis thickness) of the grid to be created.

Height

The height (y-axis thickness) of the grid to be created.

Depth

The depth (z-axis thickness) of the grid to be created.

Width Sections

The number of sections along the grid's x-axis.

Height Sections

The number of sections along the grid's y-axis.



Depth Sections

The number of sections along the grid's z-axis.

Notes

Editing values in the options dialog immediately after executing this command will allow you to see 
the effects in real time on the object.
One thing grids can be very useful for is to make template shapes to use with the Array command.

Category: Silo Manual
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Group Selection

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + G

Menu Path: Selection > Group Selection

Description

Group Selection will make a new group out of the current selection. Groups can be made up of elements of 

any single selection type. You can access and manage your groups via the Scene Editor.

Notes

Select Affected Groups and Select Next Group are handy functions when working with groups.

Category: Silo Manual



Grow Selection

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Selection > Grow Selection

Description

The Grow Selection command will select all unselected components which border the current selection, in 

effect "growing" the selection by one level. Shrink Selection provides the inverse effect.

Notes

Grow Selection should not be confused with Expand Selection, which will select not just the 
immediate neighbors, but all connected components.

Category: Silo Manual



Help Manual

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Help > Help Manual

Description

This command opens the external help manual. The help manual is produced in multiple formats including

html and pdf, which can be found in the Help directory of your Silo installation directory.

Category: Silo Manual



Hide Selection

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Display > Hide Selection

Description

The Hide Selection command will hide the current selection. Hidden elements will remain hidden when

you save a file and open it again.

Notes

You can use the Show All command to restore hidden elements.
The Scene Editor has tools for adjusting visibility of objects and face groups.

Category: Silo Manual



Hide Unselected

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Display > Hide Unselected

Description

The Hide Unselected command will hide all objects which currently are not selected. This is an easy way 

to hide objects you are not currently working with.

Notes

You can use the Show All command or the Scene Editor to restore hidden elements.

Category: Silo Manual



Inset Scale

From Nevercenter 3D Modeling Wiki

Default Shortcut: I

Menu Path: Modify > Inset Scale

Description

The Inset Scale tool is used to scale faces such that the edges of the faces selected all move an equal 

distance inward/outward from their original position. If you perform an Extrude followed immediately by 

an Inset Scale, it will have the effect of what many other programs would call an Inset command. 

Basically, Inset Scale ensures that each edge of a selected face moves the same distance inward from its 

original position, rather than simply scaling down the entire face to a smaller size.

The inset scale amount can be controlled interactively using the tool manipulator or numerically in the 

options dialog. You can select additional faces to perform this operation on while the tool is still active.

Pressing Enter or right-clicking will complete the inset scale and exit the tool.

Options

Default Amount

Determines how much to offset the inset scale when the command is called. When used with the tool
already active, it is equivalent to dragging the manipulator handle for this command to the specified 
value, and allows you to enter precise values for the current operation. This amount will also be 
applied each time you use the command in the future. Set it to 0 if you want no default adjustment.

Sticky Functionality

Press and hold the keyboard shortcut for this command to temporarily activate its manipulator, and move 



your mouse (no clicking necessary) to adjust the amount. Release the shortcut key to exit the tool. This 

allows you to model more quickly since you do not need to manually exit the tool.

Notes

At first glance, the Inset Scale tool might appear to be the same as the Local Scale tool. To see the 
difference between the two, try creating a sphere, selecting several adjacent faces, performing an 
extrusion (with the faces set to stay together), and then testing both Inset Scale and Local Scale on 
the extruded faces.
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Instance Mirror Toggle

From Nevercenter 3D Modeling Wiki

Default Shortcut: Shift + I

Menu Path: Modify > Mirroring > Instance Mirror Toggle

Description

The Instance Mirror command is an alternative to Silo's Symmetry commands which is less powerful but 

also simpler, faster, and in some cases more reliable. The general workflow is to delete half of a model 

which you want to be symmetrical and then use this command to replace the missing half with a mirrored 

instance of the remaining model. The instanced half will reflect all changes made to the original half 

instantly, and can be thought of as a preview of what your final, mirrored model will look like. When 

finished, you can use Mirror Geometry to create actual geometry for the missing half.

Options

Mirror From Axis

This is the axis along which you would like to mirror. (For example, choosing the X axis would 
mirror across the local YZ plane.) If the instance mirror appears strange or does not show up, you 
may be using the wrong axis. Note that the local axis is used, which means that the object can be 
moved or rotated in object mode and the instance mirror will update properly.

Tolerance

Vertices along the central seam between the object and the instance can be held together as if it were 
a unified object. This tolerance determines how far from the center vertices can be and still be treated 
as if they were on the center seam. If vertices are accidentally getting pulled into the center seam, you 
will want to use a smaller tolerance.

Notes

The Instance Mirror, unlike a regular Instance, cannot be selected or edited in any way.

Category: Silo Manual



Instance

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + I

Menu Path: Create > Instance

Description

The Instance command allows you to create an instance of each of the currently selected objects. Each 

instance is a copy of the original object which is updated whenever you edit that object. Instances can only 

have their scale, position, and rotation edited directly. (If you want to edit the instance directly, you will 

need to de-instantiate it. See De-instantiate Instance.)

The instance will be created in the same position as the original and selected so you can easily move it.

You can have multiple instances of the same object, allowing you to update many objects at once by only 

editing one.

Notes

Instances will be deleted when the original object is deleted.
Instances cannot be used with many functions and operations.
Instance only works in object selection mode. (See Selection Mode.)
Instances cannot be taken into vertex, edge, or face selection mode, and are only editable in object 
selection mode. (See Selection Mode.)
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Invert Selection

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Selection > Invert Selection

Description

The Invert Selection command will deselect all currently selected objects or components (faces, edges, or 

vertices) and select all selectable objects or components which were not previously selected.

Notes

Invert Selection can sometimes be useful in selecting hard-to-reach areas.

Category: Silo Manual



Keyboard Settings

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Editors/Options > Keyboard Settings

Description

The Keyboard Settings dialog allows you to assign your own keyboard shortcuts in Silo. All character 

keys and the spacebar are assignable, in conjunction with any combination of Control, Alt, and Shift keys. 

All of Silo's functions and windows can have a shortcut assigned to them. To assign a shortcut, select the 

function and then press the desired modifiers and key. To unassign a function's shortcut key, select the 

function and press Delete. Keyboard Shortcut settings can be saved and loaded via the Save and Load 

buttons, allowing users to share and download different shortcut setups.

Notes

If you assign a key which is already assigned to another function, it will be removed from the 
previous function before it is assigned.
This dialog uses Presets. You can add your own preset by copying a Silo preferences (.sip) file into 
the corresponding presets directory within the Silo install directory on your computer.
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Lathe Object

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Create > Lathe Object

Description

Description.The Lathe Object command allows you to revolve a 2D profile around an axis, creating a new 

3-dimensional object. Properties of the lathe can be changed in the options window.

Options

Sections

The number of radial sections in the lathed object.

Degrees

The degrees of rotation.

Merge Tolerance

How close end points need to be to be merged at the ends of the lathe.

Axis

The axis around which to rotate the 2D profile (World X/Y/Z, Local X/Y/Z, Endpoints).

Cap Ends

Toggle capped ends on/off.



Notes

Lathe will also work with a closed polygon or 3-dimensional object as a source, but may produce 
unexpected results. A line segment profile is recommended.
You can Lathe an open or closed line segment.
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Live UV Unwrapping

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Materials > Live UV Unwrapping

Description

When Live UV Unwrapping is enabled, you will see changes to the LSCM unwrapping of an object in 

real time as you adjust its UVs. This can be very helpful in fine-tuning the unwrapping, and in deciding 

which vertices you would like to pin (see Pin UV Vertices).

Notes

See the entry for Recreate UVs for a description of Silo's UV mapping workflow.
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Load All Settings

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Editors/Options > Load All Settings

Description

This command lets you load all of the mouse, keyboard shortcut, color, image button, and application 

settings that are contained in a single .sip preferences file.

Notes

See also Save All Settings.

Category: Silo Manual



Load Into Scene

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + Shift + O

Menu Path: File > Load Into Scene

Description

The Load Into Scene command will load another project into the current workspace, adding its materials 

and geometry to those of the current project. You can import any of the supported file types.

Many applications have a separate command called Import for files in different formats. To import files 

into Silo, simply use Open Scene or Load Into Scene, and then select the preferred alternate format.

Notes

See Supported 3D File Formats.

Category: Silo Manual



Notes

Some selections don't have a clear way in which Silo should move them with this tool, so you won't 
always get the exact results you expect.
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Local Move

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + W

Menu Path: Modify > Local Move

Description

The Local Move tool will move each element of your selection (vertices, edges, or faces) along its 

individual normal vector.

The local move amount can be controlled interactively using the tool manipulator or numerically in the 

options dialog. You can select additional faces to perform this operation on while the tool is still active.

Pressing Enter or right-clicking will complete the local move and exit the tool.

Options

Default Amount

Determines how much to offset the local move when the command is called. When used with the
tool already active, it is equivalent to dragging the manipulator handle for this command to the 
specified value, and allows you to enter precise values for the current operation. This amount will 
also be applied each time you use the command in the future. Set it to 0 if you want no default 
adjustment.

Sticky Functionality

Press and hold the keyboard shortcut for this command to temporarily activate its manipulator, and move 

your mouse (no clicking necessary) to adjust the amount. Release the shortcut key to exit the tool. This 

allows you to model more quickly since you do not need to manually exit the tool.



Local Scale

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + E

Menu Path: Modify > Local Scale

Description

The Local Scale tool will scale each group of selected faces in the plane perpendicular to their respective 

normal vectors.

The local scale amount can be controlled interactively using the tool manipulator or numerically in the 

options dialog. You can select additional faces to perform this operation on while the tool is still active.

Pressing Enter or right-clicking will complete the local scale and exit the tool.

Options

Default Amount

Determines how much to offset the local scale when the command is called. When used with the tool
already active, it is equivalent to dragging the manipulator handle for this command to the specified 
value, and allows you to enter precise values for the current operation. This amount will also be 
applied each time you use the command in the future. Set it to 0 if you want no default adjustment.

Sticky Functionality

Press and hold the keyboard shortcut for this command to temporarily activate its manipulator, and move 

your mouse (no clicking necessary) to adjust the amount. Release the shortcut key to exit the tool. This 

allows you to model more quickly since you do not need to manually exit the tool.

Notes

At first glance, the Local Scale tool might appear to be the same as the Inset Scale tool. To see the 
difference between the two, try creating a sphere, selecting several adjacent faces, performing an 
extrusion (with the faces set to stay together), and then testing both Inset Scale and Local Scale on 
the extruded faces.
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Lock Scene Lighting to Camera

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Display > Lock Scene Lighting to Camera

Description

Lock Scene Lighting To Camera, when enabled, will cause any lighting you have added to the scene to 

align with the camera rather than emanating from the position of the lights' geometry in the scene, behaving 

just like the default light. The lights' geometry will not rotate with the camera, but the lights' effect will. To

properly align lights for this mode, arrange them so that the lighting looks right from the front view (i.e. 

along the -z axis) when Lock Scene Lighting To Camera is disabled. Note that the effects of lights will 

only be visible if Use Scene Lights is enabled.

Notes

If you would like to replace Silo's default lighting with your current custom setup, use the Make 
Scene Lights Default command. Note that this will not just affect the current scene, but will also 
remain the default lighting setup for Silo generally, until another default is specified.
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Make Scene Lights Default

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Display > Make Scene Lights Default

Description

Make Scene Lights Default will cause any custom lights in the scene (which are created via the Add Light

command) to become Silo's new default lighting setup. Note that this does not apply only to the current 

scene, but rather makes this lighting setup the default for all scenes in Silo until a new default is specified. 

To restore Silo's original setup, call this command in a scene with no lights added.

Notes

You will probably want to Lock Scene Lighting to Camera, so that the lighting rotates with the view, 
before applying this command.
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Manipulator Edit Mode

From Nevercenter 3D Modeling Wiki

Default Shortcut: M

Menu Path: Selection > Manipulator Edit Mode

Description

The Manipulator Edit Mode toggle will switch the manipulator between affecting the selection (regular

mode) and having no effect on the selection (manipulator edit mode – by default the manipulator will be

drawn all white when in this mode).

When the manipulator has no effect on the selection, you can freely change its position and rotation so that 

when you leave manipulator edit mode it will relate to the selected geometry differently. This is one way 

you can edit the selection's pivot point. You can also set specific pivots and axes by turning off the 

manipulator repositioning in the Auto Orient Manipulator menu.

If you have a single object selected in object selection mode (see Selection Mode) and enter Manipulator 

Edit Mode, you can edit the object's local axis. These changes in the local axis will remain after you leave 

Manipulator Edit Mode (i.e. the object's axis will remember its new position).

Notes

The scale manipulator has no effect when in Manipulator Edit Mode.
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Manipulator Tool

From Nevercenter 3D Modeling Wiki

Default Shortcut: W, E, R, and Q

Menu Path: Selection > Manipulator Tool

Description

Manipulator Tools allow you to edit the current selection in various ways.

Move

The Move manipulator allows you to move the selection in the workspace. Drag one of the arrow 
handles to move the selection in that direction. Use Tweak Select to move the selection in the plane 
of the screen.

Scale

The Scale manipulator allows you to change the size of the selection. Drag one of the handles to 
scale the selection in that direction only. Drag the center square of the manipulator or use Tweak 
Select to scale the object in all directions.

Rotate

The Rotate manipulator allows you to change the orientation of the selection. Drag one of the 
handles to rotate in the indicated direction. Use Tweak Select to rotate in the plane of the screen.

Universal

The Universal manipulator allows you to change the orientation, position, and size of the selection. 
The shape of the handle indicates which manipulator function that handle performs. Using Tweak 
Select will allow you to drag the selection in the plane of the screen.

Options

Manipulator Size

The size, in pixels, in which the manipulator will be drawn on the screen.



Manipulator Handle Offset

Adjust this value to make the manipulator handles relatively longer or shorter compared to the 
overall manipulator size.

Show Planar Handles

When checked, certain manipulators will include extra handles that allow operations in particular 
planes, not just the x, y, and z axes. Some people prefer to have the added handles while others
prefer to keep the screen less cluttered.

Notes

You can show or hide the manipulator using the Show Manipulator checkbox in the Display menu.
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Mark UV Seams Toggle

From Nevercenter 3D Modeling Wiki

Default Shortcut: Alt + U

Menu Path: UVs/Materials > Mark UV Seams Toggle

Description

This command allows you to mark edges on your object which will correspond to edges in UV space 

where the object is broken apart when unwrapping. Edges marked as seams will be immediately broken 

apart in the UV space. Marking seams is an essential part of the Unwrap UVs Using LSCM workflow, 

but it will also affect UVs unwrapped via any other method.

Notes

See the entry for Unwrap UVs Using LSCM for a description of the LSCM unwrapping workflow.
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Mark UV Seams

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: UVs/Materials > Mark UV Seams

Description

This command allows you to mark edges on your object which will correspond to edges in UV space 

where the object is broken apart when unwrapping. Edges marked as seams will be immediately broken 

apart in the UV space. Marking seams is an essential part of the Unwrap UVs Using LSCM workflow, 

but it will also affect UVs unwrapped via any other method.

Notes

See the entry for Unwrap UVs Using LSCM for a description of the LSCM unwrapping workflow.
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Material Editor

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + Alt + M

Menu Path: Materials > Material Editor...

Description

The Material Editor allows creation and management of materials which may be applied to objects in the 

scene. Silo's materials are applied on a per-face basis, with one material allowed for each face and one 

texture image for each material.

To edit a material, click on its thumbnail to select it, and then modify its options or click on Apply to apply 

it to the current selection.

Options

Name

Change the name of the currently selected material.

Diffuse



Sets the base color for the material.

Ambient

Sets the ambient color for the material. The ambient color affects the default amount of light the 
material is treated as receiving, i.e. the brightness and color of the model before any lights are 
applied.

Specular

Sets the color of specular highlights, i.e. areas where the light is reflected most directly off the model 
and therefore brightest.

Emissive

The emissive property simulates a material which casts light of the chosen color. Note that this is a 
material property only, and will not cast light on other scene objects.

Shininess

This field allows you to set how shiny the material is, which affects its degree of specularity. More 
shininess means smaller, more intense specular highlights.

Texture

The texture file allows you to associate an image texture with the material. The image will be mapped 
according to the faces' UV coordinates, and can be adjusted using the regular manipulators while in 
texture selection mode. (See Selection Mode.)

New

Creates a new material with default colors and name.

Apply

Applies the current material to the selection. This command only works in object or face selection 
modes. (See Selection Mode.)

Select By

Selects faces in the scene with the current material applied. This command only works in face 
selection mode.

Material Thumbnails

Below the material options, you will see thumbnails of all the materials currently in the scene. Click on a 

material to change its properties. You can right click on these thumbnails for additional options, including 

removing a material from the scene, duplicating a material (which will make a new material with copied 

settings), and setting the material as Silo's default. The default material cannot be removed.



Notes

If you are using an image texture, your object needs to have UV coordinates assigned. You may 
need to use Recreate UVs.

Category: Silo Manual



Merge

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + M

Menu Path: Modify > Merge

Description

The Merge command can be used to join or combine selected components, depending on the context.

If two vertices are selected, the first will be moved to the position of the second and they will be merged to 

create a single vertex.

If more than two vertices are selected, then any selected vertices which are closer together than the Vertex 

Tolerance will be merged with one another. This tolerance can be set in the Merge Options. This is 

particularly useful if you have separate pieces of geometry whose vertices are aligned and you want to join 

them together.

If faces or edges are selected, each face or edge will be collapsed into a single vertex, as if all the vertices 

of that face or edge had been merged together. For instance, you can select an Edge Ring and use Merge to 

turn it into an Edge Loop.

If multiple objects are selected, these objects will be combined into a single object. No geometry changes 

will occur. (For example, no vertices will be merged even if they are overlapping.) This is the same as the 

Combine Objects command.

Options

Vertex Tolerance

When more than two vertices are selected, selected vertices which are closer together than this value 
will be merged when Merge is called. If only two vertices are selected, they will always be merged 



regardless of the tolerance.

Also Known As

The behavior with edges and faces is also known as Collapse in other applications.

Notes

The merge tolerance must be changed before rather than after performing the merge operation in 
order for the change to have an effect.
Faces collapsed in a Merge command will be removed from the object.

Category: Silo Manual



Mirror Geometry

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Modify > Mirroring > Mirror Geometry

Description

The Mirror Geometry command will mirror an object over a world-coordinates axis. If the object overlaps 

the axis, the overlapping portion will be deleted and replaced by the mirror. All vertices within the merge 

tolerance along the axis center will be merged.

The axis and merge tolerance for this command can be set in the Mirror Options. If the +X axis is selected, 

for example, all of the object's geometry on the positive side of the X axis will be kept, and all of the 

object's geometry on the negative side of the X axis will be replaced by the mirror. The object will be 

divided by the YZ plane. The merge tolerance allows for the object to be reconnected if there are vertices 

close to the dividing plane. If a vertex's mirrored counterpart is within the merge tolerance from the original 

vertex, it will be merged with the original vertex.

Options

Mirror From Axis

Choose the axis which contains the geometry you want to be mirrored. Any geometry on the 
opposing half will be deleted and replaced with the mirror.

Tolerance

Any vertices along the center of the mirror operation which are closer together than this value will be 
merged. This is useful if you have vertices which are very close to the center but not quite perfectly 
aligned, and you want to ensure that all center vertices are properly merged upon mirroring.

Enable Symmetry

If this option is enabled, Symmetry will be calculated and enabled for your model after the geometry 
is mirrored, allowing both sides to be updated symmetrically as you model.

Notes

You can disable symmetry mode by calling Symmetry Mode Toggle.
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Mirror UVs

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: UVs/Materials > Mirror UVs

Description

This command will arrange the selected UVs so that they reflect their mirrored counterparts. The result will 

be overlapping UVs allowing the mirrored faces to use the same texture space. An object must have 

Symmetry calculated and enabled for this command to work.

Notes

If necessary, the selected components will be broken off into a new UV island before moving, so 
that no unselected UVs are affected.

Category: Silo Manual



Mirroring

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Modify > Mirroring > ...

Description

Mirroring submenu. Contains Mirror Geometry, Instance Mirror Toggle, Calculate Symmetry, Symmetry 

Mode Toggle, and Restore Symmetry.

Category: Silo Manual



mouse button will pan the camera.

Rotate View

Rotates the camera around the selection.

Zoom View

Zooms the camera in and out.

Pan View

Pans the camera in the plane of the screen.

Select Visible New

Deselects the current selection and then selects only the visible elements (front-most) under the 
mouse selection area.

Select Visible Add

Selects the visible elements and adds them to the current selection.

Select Visible Subtract

Chooses the visible elements and subtracts them from the current selection.

Select Visible Complement

Chooses the visible elements and deselects those that were previously selected and selects those that 
were previously unselected.

Select Thru New

Deselects the current selection and then selects all elements (including obscured elements) under the 
mouse selection area.

Select Thru Add

Selects all elements under the mouse selection area and adds them to the current selection.

Select Visible Subtract

Chooses all elements under the mouse selection area and subtracts them from the current selection.

Select Visible Complement

Chooses all elements under the mouse selection area and deselects those that were previously 
selected and selects those that were previously unselected.

Context Menu



Opens the context-sensitive right-click menu (though you may assign it to a different mouse button 
than the right button).

Tweak

Tweak select allows you to do several things. If an element is already selected, using tweak select 
will perform the operation of the current manipulator (move, rotate, etc) in the plane of the screen, no 
matter where you click. If no element is selected, it will temporarily select what's under your mouse 
(visible elements only), allow you to perform the manipulator's function in the plane of the screen, 
and then deselect everything when you release the mouse button.

Notes

If you assign a key which is already assigned to another function, it will be removed from the 
previous function before it is assigned.
This dialog uses Presets. You can add your own preset by copying a Silo preferences (.sip) file into 
the corresponding presets directory on your hard drive.

Category: Silo Manual



Mouse Settings

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Editors/Options > Mouse Settings

Description

The Mouse Settings dialog allows you to completely customize Silo's mouse. At the bottom of the dialog 

is a drop-down list of presets which mimic other programs. Using any of these will let you quickly be able 

to work as with a program you may already be familiar with, though you can achieve much more 

customization than this. You can also load and save mouse setups for sharing with other Silo users, or add 

them to the presets already available.

Each of the drop-down lists of assignable functions has a small group of functions at the top which are 

only found in the Mouse Settings dialog. These are special mouse-specific functions. Below these is a full 

alphabetical list of all the other functions available in Silo. All of these can also be assigned to a keyboard 

shortcut or button. Any function can be assigned to any mouse button. Below you'll find an explanation of 

each of the mouse-specific functions.

Mouse-Specific Functions

Mirai-Style View Manipulation

This command can be assigned to the middle mouse button to emulate the way Mirai and several 
other similar programs handle camera positioning. Clicking on the middle mouse button will send 
the program into camera mode. While in this mode, dragging the mouse will rotate the view, clicking 
and dragging the middle mouse button will zoom the camera, and clicking and dragging the right 



Move and Sew

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: UVs/Materials > Move and Sew

Description

Move and Sew is used to stich together UV islands which are broken across a marked seam. It will 

arrange the islands before stitching so that a minimum amount of UV distortion occurs. Select one or more 

marked edges to perform the command. If you selected edges in the UV window, the island whose edges 

are not selected will be the one moved before stitching.

Notes

Edges will be automatically un-marked as seams after they are stitched.

Category: Silo Manual



New Scene

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + N

Menu Path: File > New Scene

Description

The New Scene command will open a new, blank scene. You will be prompted to save changes on your 

current scene, which will be closed when the new scene opens.

Notes

The default material will be carried over from the previous file, but all other materials will be lost.
Starting a new scene is akin to closing Silo and opening it again.

Category: Silo Manual



Next Button Page

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Display > Next Button Page

Description

The Next Button Page command allows you to switch to the next button page, if you have created multiple 

button pages.

This command will work whether button pages are hidden or shown. You can use the Previous Button 

Page command (assignable from the Keyboard Settings dialog) to cycle the button pages in reverse, or 

Button Page 1, Button Page 2, etc to skip directly to those button pages. The latter commands aren't found 

in the menus, but can be assigned to keyboard shortcuts, image buttons, or mouse buttons.

Notes

For more information on button pages, see Button Settings.

Category: Silo Manual



No Function

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: None

Description

No Function is primarily useful for mouse and button customization when you want a button or mouse 

click to perform no function.

Notes

This command does not appear anywhere in Silo's menu system. It must be assigned to keyboard
shortcuts, mouse clicks, or image buttons.

Category: Silo Manual



Nudge UVs

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: UVs/Materials > Nudge UVs

Description

The Nudge Uvs submenu contains useful commands for adjusting the position and rotation of UVs. The 

U and V directions represent up/down and left/right in the 2D UV viewport. The amount of adjustment for 

each operation can be edited in the options.

Notes

A useful amount for the U and V directions is 1, which will allow you to move selected UVs to 

neighboring "tiles" for organizational purposes.

Category: Silo Manual



Numerical Editor

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Editors/Options > Numerical Editor

Description

The Numerical Editor allows you to read exact values of different parameters as well as modify the 

selection by inputting numerical values. The Numerical Editor works in either world coordinates (based 

around the work grid origin) or manipulator coordinates (based around the manipulator's current 

orientation), depending on which option is selected.

Options

Position

The position of the selection with respect to the manipulator. In world coordinates, entering new X,
Y, or Z values in the position fields will cause the manipulator to be moved to those coordinates, 
taking the selected geometry with it. In local coordinates, these values determine the relative amount 
the manipulator (and selection) should be moved in each direction. For example, entering a value of 
1 in the X field while in local coordinates will cause the selection to move along the manipulator's X 
direction 1 unit each time you press Enter.



Rotation

Input only. In local coordinates, entering a value in degrees in the X, Y, or Z field will cause the
selection to be rotated around the manipulator's X, Y, or Z axis. In world coordinates, rotation still 
happens around the manipulator, but instead the world's X, Y, and Z axes are used.

Scale

Input only. As with rotation, scaling in either coordinate system still occurs around the manipulator.
In world coordinates the world axes are used to determine the direction of the scale, while in local 
coordinates the manipulator's axes are used.

Size

Contains the size of the selection in each axis direction. Adjusting these values will scale your
selection to the input size. As with rotation, scaling in either coordinate system still occurs around
the manipulator. In world coordinates the world axes are used to determine the direction of the scale, 
while in local coordinates the manipulator's axes are used.

Distance

The distance field allows you to read and edit the distance between the selected components. The 
distance is determined as the length of a line drawn between all of the selected components, in the 
order they were selected. In vertex selection mode, this is simply from one vertex to the next. In 
edge selection mode, the distance is the closest distance between the two edges if they were infinite 
lines. In face mode, the distance is measured as that of a line starting at the center dot of the first 
selected face, projected along the face's normal vector until it intersects the plane of the second face. 
If two faces are parallel, it will give the distance between the planes of the two faces. When the 
distance is changed, the first selected component remains in its original position, and other 
components are updated so that the length of the line drawn between them is equal to the new 
distance. The operation is most straightforward when only two components are selected.

Angle

The angle field shows the angle between the currently selected components where appropriate. For 
faces, this is the angle formed where the planes of two selected faces would intersect. For edges, this 
is the angle formed by the vectors represented by the two selected edges (if the edges share a vertex, 
this vertex will be the pivot of the angle). For vertices, this is the angle formed by a path drawn from 
the first vertex selected to the second to the third.

Coordinates

The coordinate system used for reading and adjusting to input in the numerical editor: world 
coordinates (based around the work grid origin) or manipulator coordinates (based around the 
manipulator's current orientation).

Notes

You can choose between the metric and English systems of measurement in the General Settings
dialog.
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Object Display Mode

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Display > Object Display Mode

Description

The Object Display Mode submenu allows you to change the way objects are displayed. Changes made 

will affect only the currently selected or active objects.

Wireframe Mode

Display the object in wireframe mode, meaning faces are not rendered.

Flat Shade Mode

Display each polygon of the object as a flat face with no smoothing.

Smooth Shade Mode



Display the object as a smooth surface.

Fast Shade Mode

Display the object as a smooth surface with the default material and no textures (for extra speed 
gain).

Ghosted Shade Mode

Display the object as a semi-transparent smooth surface.

Show/Hide Wireframe



Overlay the object's wireframe.

Show/Hide Textures

Display any textures applied to the object.

Show/Hide Normals

Display a representation of the object's face normals.

Notes

These options affect the entire object, not just selected components of an object.

Category: Silo Manual





Object Properties

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Editors/Options > Object Properties

Description

The Object Properties dialog provides information and settings concerning any currently-selected objects, 

texture proxies, or lights. This is a quick way to access object-specific properties such as shading mode, 

symmetry, and subdivision level.

Notes

The Object Properties dialog will be empty if nothing is selected or if multiple elements are selected.

Category: Silo Manual



Open Scene

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + O

Menu Path: File > Open Scene

Description

The Open Scene command will open a dialog box and allow you to choose a different scene to work in. 

The current scene will be closed after prompting you to save changes. You can open any of the supported 

file types from this dialog.

Many applications have a separate command called Import for files in different formats. To import files 

into Silo, simply use Open Scene or Load Into Scene, and then select the preferred alternate format.

Notes

See Supported 3D File Formats.

Category: Silo Manual



Orient Manipulator

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + Alt + W (To World)

Menu Path: Selection > Orient Manipulator

Description

The Orient Manipulator submenu allows you to reorient the manipulator for the current selection.

To Normal Vector

This will cause the manipulator to be aligned with the normal vector of the selection. In face mode, 
the normal vector will be the average normal of the faces. In vertex and edge selection mode, Silo 
will attempt to deduce the best normal vector. In object selection mode, this command will orient the 
manipulator to the object's local axis.

To Object

This orients the manipulator to the local axis of the selected shape or the shape whose components 
are selected. If components from multiple shapes are selected, world x, y, and z axes will be used.

To World

The manipulator will be oriented to the world-coordinate x, y, and z axes.

Notes

Silo will do its best to determine where the selection's normal ought to be, but in some cases, such as 
with a random non-planar collection of vertices, there is no clear choice.
If you would like to orient the selection to world-coordinates along with the manipulator, use Orient 
Selection To World instead.
If you would like to change the way Silo orients by default, use the Auto Orient Manipulator
commands.
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Orient Selection To World

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Selection > Orient Selection To World

Description

The Orient Selection To World command will move the selection's manipulator so it is oriented to the 

world X, Y, and Z axes, and will orient the selection along with the manipulator.

Category: Silo Manual



Orient

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Modify > Orient

Description

The Orient tool performs a combination of moving and rotating based on the geometry around the current 

selection, to keep the selection oriented to the surrounding geometry. For example, if you have the face at 

the tip of a character's tail selected, you can use Orient to rotate it in a natural way based on the unselected 

geometry further up the tail.

Orient will only work on face selections.

Sticky Functionality

Press and hold the keyboard shortcut for this command to temporarily activate its manipulator, and move 

your mouse (no clicking necessary) to adjust the amount. Release the shortcut key to exit the tool. This 

allows you to model more quickly since you do not need to manually exit the tool.

Category: Silo Manual



Paint Displacement

From Nevercenter 3D Modeling Wiki

Default Shortcut: T

Menu Path: Modify > Paint Displacement

Description

The Paint Displacement command will enter the current displacement brush and allow you to begin 

painting displacement on your model. Displacement Painting in Silo is a means of adding details to your 

shape by pushing and pulling (displacing) the surface of a subdivided (see Subdivide) model via 

brush-based tools.

On highly subdivided models, you can add fine details like wrinkles and cracks easily with displacement.

Along with adding detail, displacement painting can be useful for getting the form of a shape quickly, 

without having to worry about edge placement or other traditional modeling concerns.

The displacement brushes can be used on the base mesh as well as all subdivision levels.

Options

Paint Standard: Left Mouse Button

Paint with the current brush. If no geometry is nearby, this rotates the view.

Paint Alternate: Right Mouse Button

Paint with the current brush's alternate effect.

Adjust Radius/Strength: Middle Mouse Button

Adjust brush radius (drag left and right) and strength (drag up and down).



Exit: Esc

Exit tool.

You can assign each brush its own shortcut by selecting it in the brush editor and pressing the 
desired key. Brushes default to A, S, D, and F.

Options

The options window for this command is the Brush Editor.

Sticky Functionality

Press and hold the keyboard shortcut for this command to temporarily activate the current displacement 

brush. Release the shortcut key to exit the tool. This allows you to quickly switch between displacement 

painting and regular geometry modeling.

Notes

Displacement painting can be done on any subdivision level, or the base mesh.
For more options related to displacement painting, see the Subdivision Settings and the General 
Settings dialogs.
You can export your displacement as a normal map for use in other applications using the Generate 
Normal Map command.
If you want to use a single command to both open the Brush Editor and enter the displacement tool, 
use the Brush Editor command.

Category: Silo Manual



Paste

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + V

Menu Path: Edit > Paste

Description

The Paste command is used in conjunction with the Copy command. If you use the Copy command to 

copy selected shapes, faces, edges, or vertices to the clipboard, the Paste command will create a new shape 

that has the same structure as that which you copied to the clipboard.

Notes

You can use the Paste command repeatedly to paste as many duplicates as you want of whatever 
may be on the clipboard.
Also see the Copy command.

Category: Silo Manual



Path Extrusion Object

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Create > Path Extrusion Object

Description

The Path Extrusion Object command works much like the Extrusion Object command, except that the 

extrusion is performed along a path of your choosing. A path is represented by a set of edges with no 

faces attached. Each edge represents one extrusion segment. The options dialog allows you to change the 

way the extrusion behaves.

To perform a path extrusion, position a polygon or line segment object so that it lines up as a cross-section 

of the path you want to extrude it along. Select the cross-section, and then add the path to the selection (do 

this by holding Shift while clicking in the default setup, so both cross-section and the path are selected), 

then call the Path Extrusion Object command.

Options

Rotation

The amount in degrees that the extrusion will be rotated by the end of the path.

Scale

The amount that the extrusion will be scaled by the end of the path.

Cap Ends

If this option is enabled, the extrusion will be filled at the ends to create a closed shape.



Notes

The Edge Tool provides an easy way to create a path for your extrusion.
Path Extrusion Object works on 3-dimensional objects but may have undesired results - you will 
usually want to use relatively flat non-closed shapes, such as polygons, line segments, or grids.
If the path is subdivided, the extrusion will follow the subdivided shape. (See Subdivide.)
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Pin UV Vertices Toggle

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: UVs/Materials > Pin UV Vertices Toggle

Description

This command allows you to toggle pinning of UV vertices on an object to determine whether they will be 

affected by the Unwrap UVs Using LSCM command.

Notes

See the entry for Unwrap UVs Using LSCM for a description of Silo's LSCM unwrapping 
workflow.

Category: Silo Manual



Pin UV Vertices

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Materials > Pin UV Vertices

Description

This command allows you to pin UV vertices on an object so they will be unaffected by the Unwrap UVs 

Using LSCM command.

Notes

See the entry for Unwrap UVs Using LSCM for a description of Silo's LSCM unwrapping 
workflow.

Category: Silo Manual



Polygon Tool

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Create > Polygon Tool

Description

The Polygon Tool command will initialize a polygon/face creation tool. Use this tool by clicking and 

dragging to add successive points to the polygon and position them. Press Enter, Esc, or right-click to

finish off the polygon and again to exit the tool.

When creating a polygon with this tool, the second and third point you create will be placed at the same 

distance from the camera as the first point; the fourth point and every point thereafter will be placed in the 

same plane as the previous three points. For example, to place a polygon in the work plane, you would use

the tool from the top orthographic view.

If you have an object selected and enter this tool, you can append polygons to the existing object by 

clicking on the vertices of the object with the tool. Otherwise a new shape will be created with the

polygons you draw out.

Polygons can be used as profiles for Path Extrusion Objects, Extrusion Objects, and Lathe Objects. If you 

subdivide the polygon, the subdivided shape will be used for the Create Path Extrusion, Create Extrusion 

Shape, and Create Lathe commands.

Options

Subsegments

The number of sub-segments per segment drawn.



Notes

The normal vector of a single face created with the Polygon Tool will be determined based on 
whether the vertices were placed in a clockwise or counter-clockwise manner. If you are adding to 
an existing object, Silo will attempt to determine the direction of the normal vector based on a 
neighboring polygon. The normal vector can be reversed with the Reverse Normals command.
Calling the Polygon Tool when an object is already selected is the same as activating the Append 
Polygon tool.
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Pov Format

From Nevercenter 3D Modeling Wiki

The pov format is for exporting your Silo scenes to be rendered with the Povray renderer, including when 

calling such a renderer from within Silo through the Render command.

All instances and subdivision surfaces are written to the pov file as actual geometry, so there's no need to 

de-instantiate instances or refine control meshes. Default lighting will be provided if no user lights appear 

in the scene.

All of the options in the Import/Export Settings window will have an effect on pov file exports, except the 

Render Size fields. You must set your render size through the command options or in the Povray interface. 

If you choose to include a header or footer file, they will be added to the beginning or end of your pov file, 

respectively. A header file might, for example, include special lighting information or additional materials. 

You can then choose to not include materials (in the Import/Export Settings window) but use material 

names in your scene that are the same as special materials you've set up in your header file, and the 

renderer will use those materials from the header.

An example of what you might put in the Render Command/Program field of the Render Options dialog 

for Povray rendering is "C:\Program Files\Povray\bin\pvengine.exe/RENDER". The location of your exe 

file may be different, but adding the "/RENDER" to the end of the path will cause the file to be rendered 

with Povray immediately rather than being opened in its editor.

Notes

The only export options not supported by the pov format are the Render Size fields.
You must install your Povray renderer separately – no renderer is included with Silo.
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Recenter Object Axis

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Selection > Recenter Object Axis

Description

The Recenter Object Axis command will put the object's axis at the current center (average position of 

components) of the model. Some operations, such as merging and un-merging (via Break) two objects, or 

editing the manipulator position manually, can lead to non-centered manipulators, and this command 

allows you to reset that position.

Notes

You can use Set Object Axis to manually adjust the object's axis.

Category: Silo Manual



Recreate UVs Per Face

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: UVs/Materials > Recreate UVs > Per Face

Description

Recreates selected UVs by separating each face and arranging them in the 0-1 UV tile.

Notes

This command can be applied to component selections (such as selected faces) if you only want to 
recreate UVs for part of the object.
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Recreate UVs Using LSCM Unwrapping

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: UVs/Materials > Recreate UVs > Per Face

Description

Recreates selected UVs using the LSCM (Least-Squares Conformal Mapping) algorithm, which attempts 

to optimally flatten islands of UVs based on seam edges and pinned vertices marked by the user. The 

flattened object is cut along marked seams (think of them as seams in clothing), while pinned vertices are 

used to denote which UV vertices should not be changed by the algorithm.

This command is very similar to Unwrap UVs Using LSCM. The difference is most apparent when only 

some components of an object are selected. That command will unwrap the UVs in place, while this 

command will treat the selection as a new island or set of islands, and scale the results to fill the 0-1 UV 

tile.

Notes

This command can be applied to component selections (such as selected faces) if you only want to 
recreate UVs for part of the object.
See Mark UV Seams, Unmark UV Seams, Mark UV Seams Toggle, Pin UV Vertices, Unpin UV 
Vertices, and Pin UV Vertices Toggle for more information on marking seams and pinning vertices.
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Recreate UVs Using Neighbors

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: UVs/Materials > Recreate UVs > Using Neighbors

Description

Recreates selected UVs using UVs from surrounding geometry. The effect is sort of a healing function for 

UVs which can repair or restore problem areas. Because it relies on the UVs of neighboring geometry, it 

makes most sense to use this command on selected components, rather than on an entire object. If the 

behavior is not as desired, it may be helpful to use Grow Selection or otherwise increase the selected area.

Notes

This command can be applied to component selections (such as selected faces) if you only want to 
recreate UVs for part of the object.
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Recreate UVs Using Planar Regions

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: UVs/Materials > Recreate UVs > Using Planar Regions

Description

Recreates selected UVs by dividing the section into planar regions, based on a specified angle tolerance. 

This command is particularly useful for unwrapping hard surface models with flat surfaces and hard 

edges.

Options

Degree Tolerance

The UVs will be separated into islands based on angles which are sharper than this tolerance. 
Higher values will keep curvier sections together.

Notes

This command can be applied to component selections (such as selected faces) if you only want to 
recreate UVs for part of the object.
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Recreate UVs Using XYZ Coords

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + U

Menu Path: UVs/Materials > Recreate UVs > Using XYZ Coords

Description

Recreates selected UVs using the corresponding vertex positions on the object. Since this method is the 

default for newly created shapes, applying this comand is also like "resetting" the UVs.

Notes

This command can be applied to component selections (such as selected faces) if you only want to 
recreate UVs for part of the object.
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Recreate UVs

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: UVs/Materials > Recreate UVs

Description

Description.

Options

Layout Spacing

Spacing (in UV units) between islands when automatically laying out UVs.

XYZ

See Recreate_UVs_Using_XYZ_Coords

Per Face

See Recreate_UVs_Per_Face

Planar

See Recreate_UVs_Using_Planar_Regions

LSCM

See Recreate_UVs_Using_LSCM_Unwrapping

Neighbors

See Recreate_UVs_Using_Neighbors

Category: Silo Manual



Redo Selection

From Nevercenter 3D Modeling Wiki

Default Shortcut: Alt + Shift + Z

Menu Path: Edit > Redo Selection

Description

Silo maintains an independent undo stack for selections which can be accessed via the Undo Selection and 

Redo Selection commands. (The regular Undo and Redo commands do not remember or affect selection 

changes.) Undo Selection will step backwards in the recent history of selections, which is particularly 

helpful when a complex selection is accidentally lost. Redo Selection will step forward in the history until 

you are back to the most recent selection.

Notes

Some geometry changes (such as deleting previously selected faces) may affect the behavior of this 
command.

Category: Silo Manual



Redo

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + Shift + Z

Menu Path: Edit > Redo

Description

Redo is implemented in Silo much like in any other program – when you perform an action such as

dragging a face or rotating an edge or performing a Boolean operation between two shapes, you can

reverse the effects of that action by calling Undo and then re-perform the command by calling Redo.

Notes

You may Redo as many commands as you have undone with the Undo command. However, if you 
use Undo several times and then perform another action such as moving points or changing a 
shape's geometry somehow, the stack of commands you undid will be lost and you will not be able 
to Redo them.
Also see the entry for Undo.
Undo and Redo do not affect selections. There are separate Undo Selection and Redo Selection
commands specifically for selections.

Category: Silo Manual



Refine Control Mesh

From Nevercenter 3D Modeling Wiki

Default Shortcut: Shift + C

Menu Path: Subdivision > Refine Control Mesh

Description

The Refine Control Mesh command will cause a subdivided object's refined mesh to become its new 

control mesh. The old control mesh is deleted, and the underlying refined mesh simply becomes an editable 

non-subdivided object.

Notes

See the Subdivide topic for more information on subdivided shapes.
Refine Control Mesh will be applied to all active objects, no matter the selection mode.
Silo cannot export subdivision to external file formats. If you are exporting your object to another 
application, and you want to export the smooth, subdivided shape, you will need to use this 
command. Be sure to save a version in the native Silo format before refining the control mesh so that 
you can get your original control mesh back by re-loading.

Category: Silo Manual



Registration

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Help > Registration

Description

You can use this window to enter your registration code for Silo if you have not yet entered it, or to view 

your registration information if it has already been entered.

Category: Silo Manual



Render External

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Display > Render External

Description

The Render External command and accompanying options dialog allow you to set up Silo to work with an 

external renderer so that you can export and render your Silo scenes at the touch of a single button. What 

happens when the render command is called depends on the information you provide in the Render 

Options dialog.

Options

Render File Format

This is the format in which a temporary file will be written when the render command is called. It 
needs to be a format recognized by the renderer that you choose, as the renderer will then 
automatically be called on the temporary exported file.

Render Command

This field lets you enter the file path of the rendering program that you want to use and/or your 
renderer's command-line command. Examples of what could go in this field are "renderdl", which is 
the render command for the 3Delight renderer. Entering something similar to "C:\Program 
Files\Povray\bin\pvengine.exe /RENDER" will allow you to use the Povray renderer.

You must be sure the renderer supports rendering of the file type that you choose for the Render 
File Format. Silo will call whatever is entered in this field from the command line, followed by the 
temporary file created in the format chosen in the Render File Format option above.

Render Command Options

Here you can enter options that will be given on the command line when the render command is 
called. These options will be placed after the file name on the command line. See your renderer's
documentation for details about command line options.

The final command line output will be in the following format if the Render Format was rib, the 
Render Command was "renderdl", and the Render Options was "-a -l -t": renderdl RenderScene.rib
-a -l -t

Notes



Not all renderers may work with all export formats as expected, even if they say they support the 
format.
You must install your renderer separately – no renderer is included with Silo.
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Repeat

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + Alt + Z

Menu Path: Edit > Repeat

Description

The Repeat command will perform the last command called on whatever the current selection is. For 

example, if you select a face loop and call the Split Face Loop (see Split Loop) command, you can then call 

Repeat (preferably from an assigned shortcut or button) and it will call the Split Face Loop command on 

the current selection. This allows you to quickly perform the most recent command on different selections.

Notes

Some commands won't register as the last command, hopefully ensuring that only useful commands 
will override your previous last repeatable command.

Category: Silo Manual



Restore Symmetry

From Nevercenter 3D Modeling Wiki

Default Shortcut: Shift + N

Menu Path: Modify > Mirroring > Restore Symmetry

Description

If you have calculated symmetry (see Calculate Symmetry) for your model, you can use Restore Symmetry 

to force selected geometry to be symmetrical across the current mirror plane by moving any selected 

vertices to match their counterparts if necessary. (It is possible for your model to have symmetry assigned, 

but still have the vertices in asymmetrical places.) If you want to restore symmetry to only part of a model, 

you can select a portion in face, edge, or vertex mode and only that portion will be affected.

Notes

Formerly called "Symmetrize".

Category: Silo Manual



Reverse Normals

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Modify > Reverse Normals

Description

The Reverse Normals command will reverse the direction of each selected face's normal vector. If you are 

in object selection mode, all the normal vectors on the selected objects will be reversed. Normal vectors 

determine which direction a face considers to be pointing "out".

Notes

You can set an object to display its normals by choosing Show Normals. (See Object Display 
Mode.)
Several operations, such as Shell and Boolean, require that an object's normals be aligned in a certain 
way (usually all pointing out).

Category: Silo Manual



Revert To Autosaved

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: File > Revert To Autosaved

Description

Silo will automatically save a backup copy of your work every ten minutes (or at any interval you specify 

in the General Settings dialog), and keeps several previous versions in a row. This is in case your file gets 

corrupted somehow or Silo crashes and you lose your work. Use this command to reopen the most recent 

autosaved file. To open other previous autosaved files, open the files in the Autosaves directory in your 

Silo install directory.

Notes

You can change the interval or disable autosaves in the General Settings dialog.

Category: Silo Manual



Rib Format

From Nevercenter 3D Modeling Wiki

The rib format is for exporting your Silo scenes to Renderman-compliant renderers, including when calling 

such a renderer from within Silo through the Render command.

When Silo exports to rib files, it uses the material name given in Silo as the name of a surface shader in the 

rib file. There must be a shader in your renderer's shader library with the same name as each material for 

this to work properly. You can override material names with a single shader name using the appropriate 

check box and field in the Import/Export Settings dialog.

Most Renderman-compliant renderers have subdivision surfaces built-in to them, and if an object is 

subdivided in your Silo scene, it will export it as a subdivision surfaces object in the rib file. Refine your 

control mesh before exporting/rendering if your renderer doesn't seem to support subdivision information. 

Objects which are partially subdivided will not render properly.

All of the options in the Import/Export Settings window will have an effect on rib file exports, except the 

Include Materials check box. If you choose to include a header or footer file, they will be added to the 

beginning or end of your rib file, respectively.

Notes

The only export option not supported by the rib format is the Include Materials check box, since no 
Renderman materials are defined in the rib files anyway.
You must install your rib renderer separately – no renderer is included with Silo.

Category: Silo Manual



Save All Settings

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Editors/Options > Save All Settings

Description

This command lets you save all of your mouse, keyboard shortcut, color, image button, and application 

settings in one .sip preferences file that you can load at a later time or share with others.

Notes

See also Load All Settings.

Category: Silo Manual



Save Incremental

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: File > Save Incremental

Description

Each time you call the Save Incremental command, Silo will save your scene to a new file with a 

numerically increasing name. For example, if your file is named "Creature.sib", calling this command once

will save your scene to a new file called "Creature001.sib". The next Save Incremental call will save the

scene to "Creature002.sib", and so forth.

Options

Number Padding

The number of digits to use in the incremental file numbering.

Max Index (0 To Disable)

The last file number to save to before wrapping back around to 0. If this is set to 0, the file
numbering will not wrap back around to 0.

Notes

The next file number to save to is determined by the current file number of the file you are editing, 
not the highest file number in the current directory.

Category: Silo Manual



Save Scene As

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + Shift + S

Menu Path: File > Save Scene As

Description

The Save Scene As command allows you to save the current project. A dialog will open to allow you to 

choose a name, directory, and file type for the file.

Many applications have a separate command called Export to save in different file formats. To export files 

from Silo in alternate file formats, simply use Save Scene As, and then select the preferred file format.

Notes

See Supported 3D File Formats.

Category: Silo Manual



Save Scene

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + S

Menu Path: File > Save Scene

Description

The Save Scene command allows you to save the current project. If the file has not yet been saved a dialog 

will open to allow you to choose a name, directory, and file type. Otherwise the file will be saved with its 

current name and path.

Notes

See Supported 3D File Formats.

Category: Silo Manual



Save Screenshot

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: File > Save Screenshot

Description

The Save Screenshot command allows you to save a screenshot of your project in any of Silo's supported 

image types. The screenshot will show the entire viewport area, including all viewports if you are in a 

multiple viewport layout. On-screen buttons are automatically hidden.

Notes

If you want to take a screenshot with the buttons showing, you may be able to use your computer's 
Print Screen command.
See Supported Image File Formats

Category: Silo Manual



Save Selected Objects

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: File > Save Selected

Description

The Save Selected command allows you to save only the currently selected objects. If you are in a mode 

other than object mode, it will save all shapes which are currently editable (and have therefore been 

selected while in object mode). A dialog will open to allow you to choose a name, directory, and file type 

for the file.

Notes

See Supported 3D File Formats

Category: Silo Manual



Scale UVs Proportionally

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: UVs/Materials > Scale UVs Proportionally

Description

This command will scale all selected UVs (faces or objects only) to match the scale of the first-selected 

component.

Category: Silo Manual



Scale UVs To Bounds

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: UVs/Materials > Scale UVs To Bounds

Description

This command will scale the selected UVs so that they fit in the 0-1 UV grid, and position them within the 

grid.

Notes

Arrange UVs In Bounds is similar, but it will also rearrange individual UV islands to ensure a better 
fit.

Category: Silo Manual



Scene Editor

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Editors/Options > Scene Editor

Description

The Scene Editor offers a comprehensive, tree-based view of everything in your scene, and allows you to 

select and interact with objects. Many users will prefer to keep it open while they are working, particularly 

with complex scenes.

Selecting an item in the Scene Editor will select the corresponding item in the scene, and vice versa. Items

are divided between regular objects in the scene, groups, and UV proxies.

Buttons

Each item in the list has four buttons on the right side. All of these buttons can be clicked with the left

mouse button for regular functionality or right-clicked for a context menu which gives additional options.

Below is a list of the different buttons as they appear in the editor from left to right.

Layer

Silo allows you to treat an object or group as a layer, by making all other geometry un-editable when 
you click on the Layer button. Right-clicking allows you to choose whether you would like the other 
geometry to be hidden, set to wireframe mode, locked, or some combination of those options, and 
also allows you to set the default behavior for when you left-click on the button.

Shading

Change the display mode of the affected geometry. You can left-click to cycle between modes, or 



right-click to choose from a menu.

Hiding

Change whether the affected geometry is hidden or shown. Left click to toggle, right-click to choose 
from a menu.

Locking

Change whether the affected geometry is locked or not locked.
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Scene Info

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Editors/Options > Scene Info

Description

The Scene Info window provides information about the scene geometry and about the current selection. 

The window can be left open and refreshed when changes are made in the scene.

Options

Scene Objects

Displays the total number of objects in the scene.

Scene Faces

This displays the total number of base-mesh-level faces in the scene (i.e. not counting faces on 
subdivision levels).

Scene Iso Faces

This displays the total number of faces in the scene including those on subdivision levels higher than 
the base level.

Selection Objects



Displays the number of objects in the current selection.

Selection Faces

Displays the total number of faces in the selection.

Selection Edges

Displays the number of edges in the current selection.

Selection Vertices

Displays the number of vertices in the current selection.

Faces 3 Sided

Displays the number of 3-sided faces in the current selection

Faces 4 Sided

Displays the number of 4-sided faces in the current selection

Face >4 Sided

Displays the number of faces with more than 4 sides in the current selection.

Notes

If faces are more than 3-sided, they are still drawn as a combination of 3-sided polygons by the 
renderer. (i.e. a 4-sided face is drawn as two 3-sided polygons.) Thus the current display may be 
rendering far more 3-sided polygons than faces.
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Select Affected Groups

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + Shift + G

Menu Path: Selection > Select Affected Groups

Description

The Select Affected Groups command will select all members of any groups which the current selection is 

a member of. Any parts of the selection which are not a member of any group will be deselected.

Notes

Select Affected Groups allows you to easily work with groups as a whole.
You can view, edit, and work with groups via the Scene Editor.

Category: Silo Manual



Select All

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + A

Menu Path: Selection > Select All

Description

The Select All command will select all objects, faces, edges, or vertices which are currently selectable, 

based on the current selection mode.

Notes

To change whether or not the faces, edges, or vertices of an object are selectable, either select or 
deselect that object in object selection mode (see Selection Mode) before changing to the appropriate 
component selection mode.
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Select Loop

From Nevercenter 3D Modeling Wiki

Default Shortcut: Alt + E, or double-click Left Mouse Button

Menu Path: Selection > Select Loop

Description

The Select Loop command allows you to select rows of edges or faces on an object. Each edge selected 

designates the orientation of an edge loop. In face mode, at least two adjacent faces need to be selected to 

determine which way the face loop runs. Edges/faces will then be selected which are contiguous with the 

currently selected edges/faces and along the same orientation, until either an already-selected edge/face is 

encountered or an intersection of more or less than four edges is encountered, in which case the program 

cannot determine how to continue the loop.

Silo also supports partial loop selection. If you select two edges or faces along the same loop, only the 

portion of the loop between them will be selected. Click again to select the entire loop.

Notes

Select Loop will not work if edges or faces from more than one object are selected.
Face loops and edge loops are a powerful concept in organic modeling.
See also Select Ring.
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Select Next Group

From Nevercenter 3D Modeling Wiki

Default Shortcut: Shift + G

Menu Path: Selection > Select Next Group

Description

The Select Next Group command allows you to switch between selected groups without opening the 

Scene Editor. If you have created more than one group, this command will select the next group listed in 

the Scene Editor. If no group is selected, the first group on the list will be selected by this command.

Only groups who's members are of the same type as your current selection mode will be selected, so you 

have to be in Face Selection Mode to select any face groups with this command.

Notes

You can view, edit, and work with groups via the Scene Editor.
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Select Path

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Selection > Select Path

Description

The Select Path command will take two selected components and select the shortest path of components 

between them. The command only looks at the last two selected components, so you can add a path 

selection without disturbing anything that might already be selected. You can also then immediately select 

one more component and perform the operation to continue the path to that component, and repeat the 

process as much as you like.

Notes

The shortest path between two elements on a loop is frequently (though not always) a partial loop.
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Select Ring

From Nevercenter 3D Modeling Wiki

Default Shortcut: Alt + R

Menu Path: Selection > Select Ring

Description

The Select Ring command allows you to select parallel edges that form a ring around (or partially around) 

an object, or a face loop if in face selection mode (see Select Loop ). Each edge selected designates the 

orientation of an edge ring. Edges which are on the opposite side of a four-sided face from the selected 

edge will be in turn selected, and edges on the opposite sides of four-sided faces from those edges will be 

selected recursively, continuing until either an already-selected edge is encountered or a face with more or 

less than four sides is encountered, in which case the program cannot determine how to continue the edge 

ring.

Notes

Many people use the Cut command in conjunction with Select Ring to add detail to a model. This 
can also be accomplished using Select Loop followed by Split Loop.
Face loops, edge loops, and edge rings are a powerful concept in organic modeling.

Category: Silo Manual



Select Special Geometry

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Selection > Select Special Geometry

Description

The Select Special Geometry command allows you to select different types of geometry with special 

characteristics which you can specify in the options. Often, you will use this command to identify 

potentially problematic geometry. If you are in object selection mode and no objects are selected, these 

commands will apply to all geometry in the scene. Otherwise it will only apply to that geometry which has 

been selected in object selection mode, regardless of which selection mode you are currently in.

Options

The Options consist of a drop-down menu of component types and value comparisons, and then a field to 

enter a value to compare against. Some common examples are listed below.

Select Non-4-Sided Faces

Selecting Faces with sides != 4 will select all faces which are not commonly known as quads or
quadrilaterals (four-sided).

Select Non-3-Sided Faces

Selecting Faces with sides != 3 will select all faces which are not triangles.

Select Over-4-Sided Faces

Selecting Faces with sides > 4 will select all faces which have 5 or more sides and are neither quads 
nor triangles.



Select Over-2-Faced Edges

Selecting Edges with faces > 2 will select all edges which have more than two faces attached. This is 
known as non-manifold geometry and can cause subdivision errors within Silo, disallow boolean 
and shell operations, and cause other difficulties.
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Select Viewport Image

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Display > Select Viewport Image

Description

The Select Viewport Image command will select the background image, if any, in the current viewport, 

allowing you to edit its position, orientation, and size with the standard geometry manipulators or the 

numerical editor.

To help avoid accidental selection while modeling, you cannot select a viewport background image directly 

by clicking on it. This function is the only way to select a background image. Once selected, the image can 

be edited using the regular Move, Rotate, Scale, and Universal manipulators (see Manipulator Tool), 

allowing you to position it as desired. It can also be edited with the Numerical Editor for precise 

positioning.

Notes

For more information on viewport images, see Set Viewport Image.
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Selection Mode

From Nevercenter 3D Modeling Wiki

Default Shortcut: A, S, D, F, and G

Menu Path: Selection > Selection Mode

Description

In Silo, the Selection Mode determines which scene elements can be selected and manipulated at a given 

time. Most commands will require a certain selection mode, since they can only be applied to that type of 

geometry. The available modes are object, face, edge, vertex, and multi. All modes except object selection

mode are considered component selection modes.

The component selection modes are also object-specific. If you select one or more objects in object 

selection mode, and then go into a component selection mode, only components of selected objects will be 

selectable. This allows you to focus your edits on certain objects and not accidentally select unwanted 

geometry. For example, if you had a complex scene of a city where each building was a separate object, 

you could select a single building in object mode, and then go into one of the component modes to edit that 

building. No other geometry from the city would be editable until you went back into object mode. If no 

objects are selected, all objects will be editable when entering a component selection mode.

Object Selection Mode

The object selection mode plays a key role in Silo. An object can be any combination of geometry, 
but typically each time you create a new primitive or load in a shape, it is a separate object as would 
be expected. Geometry can not be continuous across two separate objects, so if you want to connect 
two objects together to make a single surface, you will need to merge them into a single object first. 
Object-specific properties include display mode, subdivision level, and symmetry.



Face Selection Mode

This mode lets you select the individual faces (also known as polygons) which comprise an object.
Each face is made up of three or more vertices and the edges which run between those vertices.

Edge Selection Mode

This mode lets you select the individual edges (also known as lines) which lie between the faces or 
as individual line segments in an object. Each edge is defined by the two vertices at its endpoints.

Vertex Selection Mode

This mode lets you select the individual vertices (also known as points or control points) which 
define the faces and edges of a model.

Multi Selection Mode

With this mode, faces, edges, and vertices will all be selectable, although you can still only select 
components of one type at a time. If you have an edge selected, for example, you will only be able to 
select edges until you deselect everything, at which point you can select any edge, vertex, or face and 
continue selecting more of that component. Many users use this mode almost exclusively rather than
specifying one of the component types.

Notes

The Convert Selection To submenu performs similar functions, but will attempt to maintain an 
equivalent selection across modes.
You can make multiple objects into a single object using Merge or Combine Objects. You can make 
part of an object into a new, separate object using Break.
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Selection Style

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Selection > Selection Style

Description

Selection styles in Silo change the behavior when you click and drag using one of the selection commands 

(e.g. Select New).

Paint

With this style, each component's selection will be affected as you drag your cursor over it, allowing 
you to effectively paint selection or de-selection.

Area

Clicking and dragging will produce a bounding box, and all editable components within that box 
will be affected.

Lasso



Lasso works like Area, except that instead of a box, clicking and dragging will allow you to draw a 
freehand selection area.

Options

Only Select Fully Enclosed (Area Selection Only)

This option for Area Style Selection lets you determine whether you need to fully enclose a 
component in the area selection or only need to partially enclose it in order for it to be considered in 
the selection.
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Set Object Axis

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Selection > Set Object Axis

Description

The Set Object Axis command can be used to assign the currently selected object's axis to wherever the 

manipulator is currently. You can use this to place the object's pivot point (which is normally at the center 

of the object) wherever you like. A common example is rotating an object about an edge. Select the edge, 

use Set Object Axis, switch to object mode (see Selection Mode), and rotate the object.

Notes

If you have any of the Auto Orient Manipulator options enabled, then the orientation of the 
manipulator will update appropriately when you switch to object mode.
You can use Recenter Object Axis to reset the axis.
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Set Viewport Image

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Display > Set Viewport Image...

Description

The Set Viewport Image command allows you to choose an image to use as a background or reference in 

the current viewport.

Background images can be any image in any of Silo's supported image formats. Once set, this image will 

be drawn behind all geometry and cannot be selected except with the Select Viewport Image command. 

When the viewport image is selected with that command, it can be edited with the regular Move, Rotate, 

Scale, and Universal manipulators (see Manipulator Tool), allowing you to position it as desired. It can 

also be edited with the Numerical Editor for precise positioning. The background image can be changed by 

using the Set Viewport Image command again, and it can be removed with the Delete Viewport Image

command. No viewport image can be set for the Perspective and Free Ortho cameras.

Notes

The background image will be drawn using Silo's texture resolution, which can be set in the General 
Settings window. Images may appear blocky or blurry if the resolution is low.
See Supported Image File Formats to see which image formats can be used for viewport images.
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Shell

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Modify > Shell

Description

The Shell tool allows you to give thickness to the individual polygons of an object by making a shell of 

new polygons which mimics the shape of the object but is displaced slightly. This operation is useful, for 

example, in giving thickness to the walls of a modeled house or to a character's clothing. When the 

command is executed, the tool manipulator will load - dragging on its handles will adjust the thickness of 

the shell. Press Enter or right-click to create the shell and exit the tool.

Options

Default Amount

Determines how much to offset the shell when the command is called. When used with the tool
already active, it is equivalent to dragging the manipulator handle for this command to the specified 
value, and allows you to enter precise values for the current operation. This amount will also be 
applied each time you use the command in the future. Set it to 0 if you want no default adjustment.

Sticky Functionality

Press and hold the keyboard shortcut for this command to temporarily activate its manipulator, and move 

your mouse (no clicking necessary) to adjust the amount. Release the shortcut key to exit the tool. This 

allows you to model more quickly since you do not need to manually exit the tool.

Notes



Shell can only be performed in object selection mode. (See Selection Mode.)
Shell is different from simply scaling a copy of the geometry, because all of the new polygons move 
along the direction of the original polygons' normals.
There are many situations in which it is mathematically and logically impossible for the Shell 
operation to work as you may wish. You cannot perform a Shell operation when one or more of the 
edges in the shape have more than two faces attached to it.
All of the object's face normals must be oriented in the same direction ("in" or "out") for Shell to 
work properly. Use the Reverse Normals command to change the normal vectors for selected faces, 
or use Unify Normals on the entire object.
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Show All

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Display > Show All

Description

The Show All command will show/unhide all objects and faces in the scene if you are in object mode, or 

faces of editable objects if you are in another selection mode.

Notes

You can also hide and unhide items using the Scene Editor.
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Show Buttons

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Display > Show Buttons

Description

Show Buttons enables the display of user-customizable buttons in the modeling window. To find out more 

about buttons and button pages, see the Button Editor (see Button Settings).

Notes

This option affects all viewports.
One alternative to hiding buttons is to create a blank button page.
You can assign the Show Buttons command to a keyboard shortcut or a button.

Category: Silo Manual



Show Lights

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Display > Show Lights

Description

Show Lights, when enabled, will display the geometry of any custom lights that you have added to your 

scene, allowing you to select and edit them. It is useful to disable the display of lights in order to keep the 

modeling space clear and uncluttered. This command will not enable or disable the effect of the lights on 

objects in the scene. The Use Scene Lights command performs that function.

Category: Silo Manual



Show Manipulator

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Display > Show Manipulator

Description

The Show Manipulator option, when unchecked, allows you to work without the manipulators. You'll 

probably want to assign the Constrain To commands to keyboard shortcuts or mouse buttons if you're 

working in this way.

Category: Silo Manual



Show Viewport Images

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Display > Show Viewport Images

Description

The Show Viewport Images option allows you to show or hide all the viewport background images.

Notes

For more information on viewport images, see Set Viewport Image.
This option affects all viewports, not just the current viewport.

Category: Silo Manual



Show Work Grids

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Display > Show Work Grids

Description

The Show Work Grids option, when checked, displays work grids representing XY, YZ, or XZ plane in 

each viewport, as appropriate. All grids are hidden when this option is unchecked, and shown when 

checked on the menu.

Notes

This option affects all viewports, not just the active viewport.
Grid options can be edited in the Display Settings dialog.

Category: Silo Manual



Shrink Selection

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Selection > Shrink Selection

Description

The Shrink Selection command will remove the outermost selections from an island of selected 

components, in effect "shrinking" the selection by one level. Grow Selection provides the inverse effect.

Category: Silo Manual



Slide

From Nevercenter 3D Modeling Wiki

Default Shortcut: K

Menu Path: Modify > Slide

Description

The Slide tool allows you to slide any number of selected edges proportionally along the surface of the 

model. This is done by treating edges which intersect the selection as rails to slide along. Slide currently 

works only with edges.

Options

Default Amount

Determines how much to offset the slide when the command is called. When used with the tool
already active, it is equivalent to dragging the manipulator handle for this command to the specified 
value, and allows you to enter precise values for the current operation. This amount will also be 
applied each time you use the command in the future. Set it to 0 if you want no default adjustment.

Sticky Functionality

Press and hold the keyboard shortcut for this command to temporarily activate its manipulator, and move 

your mouse (no clicking necessary) to adjust the amount. Release the shortcut key to exit the tool. This 

allows you to model more quickly since you do not need to manually exit the tool.

Notes

Slide is often used in conjunction with Select Loop to quickly modify or enhance a shape.



Category: Silo Manual



you may prefer to use depending on the situation.

Category: Silo Manual



Smooth

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Modify > Smooth

Description

The Smooth command will in essence average the positions of the selected vertices, evening out 

irregularities and extremes and generally smoothing the surface. The command works in any selection 

mode, but always works on the vertices of the selection.

Options

Iterations

Determines how many times the algorithm will be run when you use the Smooth command, and 
thus the amount of smoothing which will occur.

Volume Preservation

A factor intended to counter the natural side effect of shrinking the model which Smooth can have. 
The closer this value is to 1, the more the algorithm will attempt to expand the vertices while 
performing the Smooth operation.

Also Known As

This function is also known in other applications as Average Vertices, Tighten, or Relax.

Notes

There is also a Smooth brush when using displacement painting (see Paint Displacement), which 



Snapping

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Selection > Snapping

Description

This submenu allows you to switch between Silo's multiple methods of snapping. Silo's snapping allows 

you to constrain the movement of your selection (particularly with the Move manipulator) in various ways.

With snapping enabled, using different handles of the manipulator will let you snap along different axes.

For example, to snap a vertex to the same height in the y direction as a second vertex, do the following. 

First select the first vertex. Then, with the move manipulator active and component snapping enabled,

select the y axis of the manipulator and drag the mouse over the second vertex. The second vertex will

become highlighted and the y value of the first vertex will then be snapped to the y value of the second 

vertex.

Component

With component snapping, Silo will snap the current selection to components as you drag your 
mouse over them. This snapping is useful if you need to precisely align something with a face, edge, 
or vertex.

Surface

Silo will snap the selection to the surface of any unselected objects as you drag your mouse over it. 
This snapping is useful if you want to make your selection conform to another surface, such as 
creating new topology over an imported model, or adding clothing to a character. Be sure the surface 
you want to snap to is unselected in Object mode (see Selection Mode).

Grid

Silo will snap to the intersection points of the work grid. The grid spacing can be modified in the 
Display Settings, and its visibility can be toggled using Show Work Grids in the Display menu.

No Snapping

Snapping will be disabled.
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Soft Selection

From Nevercenter 3D Modeling Wiki

Default Shortcut: Alt + Shift + S

Menu Path: Selection > Soft Selection

Description

Soft Selection gives your surface modifications a soft, clay-like feel. When Soft Selection is enabled, the 

effects of move, scale, and rotate manipulator edits will be the same as usual on selected elements (vertices, 

edges, or faces), but will also be distributed to adjacent vertices based on a gradual falloff. This causes 

edits to have a smoothed or softened effect on the model.

You can tell how much the transformations will affect individual vertices by the coloring of vertices when 

soft selection is enabled. (These colors can be changed in the Color Settings dialog).

The radius and falloff of the soft selection, or amount which the effect decreases with distance away from 

the manipulator, can be edited in the Soft Selection Options window. You may also consider assigning 

soft selection adjustments to the mouse scroll wheel with the Soft Selection Falloff/Radius Up/Down 

commands found in the command list.

Options

Type

There are two types of soft selection -- Surface, and Spherical. Spherical is based purely on distance 
from the manipulator. Surface is based on distance across the surface from the nearest selected point. 
An object with folds, for example, may have points which are very close with Spherical falloff, but 
much farther away with Surface falloff.

Radius



The maximum distance from the selection at which vertices should still be affected.

Falloff

The rate at which the strength of the soft selection decreases as it gets farther away from the 
selection.

Notes

Changes made using the Numerical Editor will also be affected by soft selection.

Category: Silo Manual



Sphere

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Create > Sphere

Description

The Sphere command will create a sphere shape at the center of the work grid, based on parameters

specified in the options window.

Options

Radius

The distance out from the center of the sphere.

Sections

The number of horizontal sections.

Height Sections

The number of vertical sections.

Notes

Editing values in the options dialog immediately after executing this command will allow you to see 
the effects in real time on the object.
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Spin Edge

From Nevercenter 3D Modeling Wiki

Default Shortcut: /

Menu Path: Modify > Spin Edge

Description

The Spin Edge command allows you to change the way an edge divides two faces, by rotating the edge. A 

single edge which is connected to precisely two faces must be selected in order for this command to work. 

The edge will in effect be rotated by using a different pair of the faces' vertices for its endpoints.

Notes

It may be necessary to perform this operation multiple times in a row to achieve the desired edge 
placement.

Category: Silo Manual



Split Loop

From Nevercenter 3D Modeling Wiki

Default Shortcut: Shift + X

Menu Path: Modify > Split Loop

Description

The Split Loop command will split any loop or strip of faces or ring of edges that you have selected down 

the middle, along the path of the selection. When this command is called, the faces will be split and the tool 

manipulator will initialize. Dragging any handle of this manipulator will adjust the position of the splitting 

edges. If single faces are selected, Silo will guess the orientation of how you want the face to be split.

Sticky Functionality

Hold the keyboard shortcut to split a loop and temporarily adjust the new edge. Release the shortcut to exit 

the tool.

Context Sensitivity

In Edge mode (see Selection Mode), If only contiguous edges are selected (such as an edge loop), Split 

Loop will Bevel those edges. Otherwise, it will create a new edge along the midpoints of the selected 

edges.

Notes

Also see the entry for Select Loop.



Category: Silo Manual



Notes

When you subdivide an object several times, each level of the subdivision is saved in memory, so 
subdividing a large object several times can use a lot of memory. When you Unsubdivide, the 
subdivided shapes are still retained in memory, allowing you to go back to the higher level of 
subdivision without the program having to recalculate the subdivided mesh.
Subdivide can be performed on whole objects only.
Subdivide will be applied to all active objects, no matter the selection mode.
Subdividing an instance will cause its parent object to be subdivided.

Category: Silo Manual



Subdivide

From Nevercenter 3D Modeling Wiki

Default Shortcut: C

Menu Path: Subdivision > Subdivide

Description

The Subdivide command will subdivide all active objects one level. When an object is subdivided it has 

two elements: an editable control mesh and an underlying refined mesh. The refined mesh (also sometimes 

called the "iso surface") represents the visible object, but it can't be edited directly (use the Refine Control 

Mesh command if you want to edit this mesh). Instead it is edited by making changes to the coarser 

polygon control mesh.

When an object is subdivided for the first time, its original geometry is used for the control mesh, and the 

refined mesh is a smoothed version of that geometry. An object can be subdivided multiple times, which 

results in a smoother refined mesh which is controlled by the same control mesh.

In Silo you can subdivide anything, whether it be an object with faces or a sequence of edges used as a line 

segment. Many actions, when performed with a subdivided shape, will use the subdivided mesh rather 

than the control mesh. These include Lathe Object, Extrusion Object, Path Extrusion, and Boolean

operations. This allows you to create a profile for a lathe in rough form, then subdivide (or partial 

subdivide) the profile to a desired smoothness, adjusting the shape with the outer control mesh, then create 

the lathe with the inner subdivided object.

Sticky Functionality

Press and hold the keyboard shortcut for this command to temporarily preview the next subdivision level. 

Release the shortcut to go back to the current subdivision level.



Subdivision Settings

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Editors/Options > Subdivision Settings

Description

The Subdivision Settings dialog allows you to change options related to subdivision and displacement 

painting in Silo. Some of these options can have complex effects, and it is recommended you read the 

guide to displacement painting for more information.

Options

Max Subdivision Level

This setting will keep Silo from allowing you to subdivide an object more than the specified number 
of levels. This is mainly to protect against accidental subdivision above levels your computer can 
handle without slowing down or crashing.

Propagate Displacement to Base

Separate from the following option for all subdivision levels, you can choose whether or not you 
want changes made via displacement painting to affect the base mesh. One reason to disable this is if 
you have a finalized model for which you are creating displacment maps, and you want to be sure 
the model's vertex positions are not modified.

Propagate Displacement to Lower Subdivisions

This is the same as the preceding option, except it applies to all levels and not just the base mesh. If 
you disable this option, then displacement changes made on one subdivision level will not affect any 
lower subdivision levels, allowing you to treat each subdivision level as a separate layer. For 
instance, you could experiment with painting veins on a model, and if you don't like your painting, 
you can clear the subdivision on the current level and start over, and none of this will affect the 
larger details you have painted on lower subdivision levels.

Optimized Face Draw Limit



If your model has more faces than this number, Silo will employ special techniques to help speed up 
the display and interactivity. The main technique is to automatically unsubdivide the model one level 
as you rotate or interact with it.

Smooth Shade at SubD Level (0 to disable)

This option allows you to force Silo to use smooth shading on subdivided objects at and above the 
specified level, even if the object is set to a flat-shaded display type. Set it to 0 to disable.

Notes

For more information about displacement painting, see Paint Displacement.

Category: Silo Manual



Supported 3D File Formats

From Nevercenter 3D Modeling Wiki

Supported 3D file loading formats are *.sib, *.sia, *.obj, *.fac, *.3ds, and *.dxf.

Supported 3D file saving formats are *.sib, *.sia, *.obj, *.fac, *.3ds, *.dxf, *.stl, *.rib, and *.pov.

Category: Silo Manual



Supported Image File Formats

From Nevercenter 3D Modeling Wiki

Supported image loading formats are *.png, *.jpg, *.bmp, *.tga, *.gif, and *.xpm.

Supported image saving formats are *.png, *.jpg, and *.bmp.

Category: Silo Manual



Surface Tool

From Nevercenter 3D Modeling Wiki

Default Shortcut: Shift + P

Menu Path: Create > Surface Tool

Description

The Surface Tool is a sophisticated, context-sensitive tool for interactively creating strips of polygons. It is 

commonly used in conjunction with Surface Snapping to re-topologize an existing mesh. It can be used on 

a selected object to extend an existing mesh, or with nothing selected to create a new object.

Selection

The Surface Tool defaults to Multi Select mode. Clicking on a component will switch the selection mode to 

that type until you right-click or finish adding a strip of polygons. The tool behavior changes according to 

the current selection mode, as detailed in the "Context Sensitivity" section below. If a component is 

selected, right-clicking will deselect the component and return the tool to Multi Select.

Objects which are selected when you enter the tool will be available to add geometry to. Objects which are 

deselected will be used as snapping targets if Surface Snapping is enabled. If you are using the tool to 

create new geometry over an existing object, de-select the existing object before entering the tool.

Tweak

The positions of components of the active shape, including those added by the tool, can be tweaked by 

simply clicking and dragging on them. (Note that this is different than using the Tweak command, which 

will not work while this tool is active. The behavior is the same.) If you tweak a component which is 

available to add geometry to (i.e. it is on the border of an open surface), the component will remain selected 

so you can start adding geometry. Right-click to deselect if you wish to continue tweaking.

Context Sensitivity

Vertex Mode

The behavior is similar to that of the Polygon Tool, which lets you draw or select each vertex of a 
new face in order. Click and drag to move vertices as you place them. Right-click to complete the 
face. If you enter the tool with nothing selected, it will default to Vertex mode so you can draw out 
the first face of your new object. This selection mode is also the only way for the Surface Tool to 
create polygons with more or less than 4 sides.



Edge Mode

A new edge will be extruded from the currently selected edge. Move the mouse without clicking to 
position the new edge. Click to create the edge, and drag to change the edge's size if desired. 
Right-click to cancel if you don't want to create a new edge.

Face Mode

A new edge will be extruded from the nearest edge of the currently selected face. Move the mouse 
without clicking to position the edge. Click and drag to draw out a strip of polygons. Each polygon 
will be the same length as the first-created polygon. (Let go and repeat the click and drag process if 
you want sections of a different length.) Right-click to cancel if you don't want to create a new edge.

Highlighted

If you are in Face or Edge mode, you can use highlighted edges to change the behavior of the tool. If 
the highlighted edge is adjacent to the selected edge, then clicking will merge the new face with that 
edge as well. Click and drag to position the remaining free vertex. This is useful if you want to fill in 
rows of polygons, for example.

If the highlighted edge is not adjacent to the selected edge, it will be used as the termination point of 
the current strip of polygons.

In both cases, Vertices will be highlighted in red where the new geometry will be merged with 
existing geometry.

Common Workflow

The most common use of the surface tool is to create a new (usually lower-poly) object whose geometry 

follows that of some other object. To do this, deselect your target object and enter the tool. Make sure 

Surface Snapping is enabled and the target object is Ghost shaded. (This can be set up automatically in the 

tool's options.)

The tool will start in vertex mode, allowing you to draw the first polygon of your new object over the 

existing object. From this point, you can draw out new geometry by selecting vertices, edges, or faces and 

extending them. Be sure to highlight edges where you want the new geometry to be merged. Surface 

snapping is projected based on the current view, so it is helpful to remember to rotate the camera as you 

work to give a good projection. Use Vertex mode to draw faces which are not four-sided, or to fill in 

holes.

Options

Enable Surface Snapping on Tool Startup

This option will automatically enable Surface Snapping when the tool starts up, and revert snapping 
to its previous state after you exit the tool. This is useful if you use the tool primarily for drawing 
new geometry over an existing shape.

Ghost Shade Unselected Objects on Tool Startup



This option will automatically set unselected objects to Ghost shading mode, and revert their shading 
modes to the previous settings on exit. This is useful if you use the tool primarily for drawing new 
geometry over an existing shape, as it is easier to see the new geometry.

Notes

The Surface Tool works as a sticky key, meaning you can hold down the hotkey to temporarily enter 
the tool. Some users replace Tweak with this command because of its added functionality.

Category: Silo Manual



Symmetry Mode Toggle

From Nevercenter 3D Modeling Wiki

Default Shortcut: Alt + N

Menu Path: Modify > Mirroring > Symmetry Mode Toggle

Description

You can use this command to enable or disable symmetry on your model. If symmetry has not yet been 

calculated (see Calculate Symmetry), it will be calculated before being enabled. You may wish to 

temporarily disable symmetry in order to add asymmetrical details to your model.

Category: Silo Manual



Toggle Current Subdivision

From Nevercenter 3D Modeling Wiki

Default Shortcut: Alt + V

Menu Path: Subdivision > Toggle Current Subdivision

Description

The Toggle Current Subdivision command will switch an object back and forth between the current 

subdivision level and the base mesh, allowing you to skip the step of unsubdividing and re-subdividing 

multiple times in order to compare your subdivided shape at the current level with the base mesh.

Sticky Functionality

Hold the keyboard shortcut down to temporarily toggle between subdivision levels, and then let go to 

return to the current level.

Category: Silo Manual



Topology Tool

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + T

Menu Path: Create > Topology Tool

Description

The Topology Tool is a geometry creation tool based on a pen-like drawing system. The user draws 

directly on top of existing objects to describe a new topology, and can add, edit, erase, and delete strokes. 

Upon pressing Enter, a new object is created based on the drawn topology. This freeform system for 

redefining topology can be used for cleaning up high-res models, adding clothes, creating a skin over 

multiple objects, and more. Topology Tool strokes are saved with the model, and can be further edited by 

re-entering the tool.

Options

Maximum Face Size

Any faces that would be generated by the topology tool which have more sides than this will be left 
as holes. This is useful for things like eyes and borders anytime you do not have a closed mesh.

Offset

This determines how far the generated mesh will be offset from the source. It does not change how 
far away the strokes are drawn.

Merge Tolerance

The maximum distance at which separate intersections will be treated as a single point during mesh 
generation. If some intersections are not detected and you get subdivision errors, raise the tolerance. 
If separate intersections are getting merged to a single point, lower the tolerance.

Use Auto Tolerance

When checked, Silo will attempt to automatically determine the merge tolerance needed for 
generating the mesh rather than using the value in the Merge Tolerance field above.



Delete All Strokes

Deletes all strokes currently drawn, allowing you to start over with a new topology.

Controls

New Stroke: Left Mouse Button

Draw out a new stroke.

Continue Stroke: Middle Mouse Button or Shift + Right Mouse Button

Continue or select the closest stroke from the closest endpoint.

Close Loop: Right Mouse Button or Ctrl + Left Mouse Button

Makes the selected stroke close back on itself to form a loop.

Delete Stroke: Delete

Erase current stroke.

Generate Mesh: Enter

Generate mesh from strokes and exit the Topology Tool.

Exit: Esc

Exit the Topology Tool.

Selecting edges before entering the Topology Tool will cause those edges to be drawn automatically.

Also Known As

The Topology Tool was known as the Topology Brush in previous versions of Silo.

Notes

If the source object is small when you first load it into the scene, scale the object larger rather than 
zooming in. The Topology Tool is more inconsistent with small scale models.
A quick way to find distances and scale is to select two points on a model, go to the Numerical 
Editor, and then check the distance field.
Your edge loops do not have to be one continuous stroke each. You can simply start a new stroke 
which crosses the same intersection point as another stroke. This is also useful for joining two 
separate strokes.
You can terminate as many edges as you want at a single intersection. As long as they all intersect 
within the tolerance, they will all join at a single vertex after mesh generation.
You may need to Unify Normals and/or Reverse Normals after mesh generation.
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Torus

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Create > Torus

Description

The Torus command will create a torus shape at the center of the work grid, based on parameters specified 

in the options window.

Options

Inner Radius

The distance out from the center point to the inner edge of the torus.

Outer Radius

The distance out from the center point to the outer edge of the torus.

Radial Sections

The number of sections along the "length" of the torus (vertical sections).

Circumference Sections

The number of sections along the "thickness" of the torus.

Notes



Editing values in the options dialog immediately after executing this command will allow you to see 
the effects in real time on the object.

Category: Silo Manual



Triangulate

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Modify > Triangulate

Description

The Triangulate command will triangulate all selected objects or faces by dividing faces with more than 

three edges into multiple faces, all with three edges. The program will determine where to add the 

necessary edges, but the object is guaranteed to have only three-sided faces. If a face has been made 

extremely non-planar to the point where it can't be drawn, then it can't be triangulated either. Triangulate 

can be used in object or face selection modes.

Notes

Triangulate can be useful for exporting to some file types or programs which only support 
three-sided faces.

Category: Silo Manual



Tutorials

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Help > Tutorials

Description

This window provides a simple browser which includes several tutorials to help familiarize users with 

some of Silo's many features. Included in the browser are forward and back buttons, as well as a Home

button to take you directly to the tutorials index at any point.

Notes

This window may be useful in conjunction with the Context Help window.

Category: Silo Manual



Tweak

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + Left Mouse Button

Menu Path: None

Description

Tweak is one of the most useful selection functions in Silo, and can only be assigned to a mouse button. If

you have something selected, clicking and dragging with Tweak will perform the function of the current 

manipulator in the plane of the screen without having to actually click directly on the manipulator. If

nothing is selected, Tweak will select the component or object temporarily, perform the manipulator action 

while dragging, and then deselect when you release the mouse button.

If, for example, you have the Move Manipulator active, tweaking will move selected components in the 

plane of the screen without having to click directly on the manipulator.

Notes

Tweak works with several manipulators to perform their specific functions.
Tweak can only be assigned to mouse buttons.

Category: Silo Manual



Uncrease Edges

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Subdivision > Uncrease Edges

Description

The Uncrease Edges command allows you to un-crease an edge which has previously been creased with 

the Crease Edges command. This command and the Crease Edges command only affect the inner mesh of 

subdivided shapes.

Notes

For an explanation of creases, see Crease Edges.
Uncrease Edges only works in edge selection mode. (See Selection Mode.)

Category: Silo Manual



Undo Selection

From Nevercenter 3D Modeling Wiki

Default Shortcut: Alt + Z

Menu Path: Edit > Undo Selection

Description

Silo maintains an independent undo stack for selections which can be accessed via the Undo Selection and 

Redo Selection commands. (The regular Undo and Redo commands do not remember or affect selection 

changes.) Undo Selection will step backwards in the recent history of selections, which is particularly 

helpful when a complex selection is accidentally lost. Redo Selection will step forward in the history until 

you are back to the most recent selection.

Notes

Some geometry changes (such as deleting previously selected faces) may affect the behavior of this 
command.

Category: Silo Manual



Undo

From Nevercenter 3D Modeling Wiki

Default Shortcut: Ctrl + Z

Menu Path: Edit > Undo

Description

Undo is implemented in Silo much like in any other program – when you perform an action such as

dragging a face or rotating an edge or performing a boolean operation between two shapes, you can

reverse the effects of that action by calling this command.

Notes

The default material will be carried over from the previous file, but all other materials will be lost.
Starting a new scene is akin to closing Silo and opening it again.
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Unify Normals

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Modify > Unify Normals

Description

The Unify Normals command will attempt to align each selected face's normal vector to those of the faces 

around it, or, if in object selection mode, it will attempt to align all of the object's face's normal vectors to 

each other. On unusual geometries a complete unification of normals may be impossible, but in the 

majority of cases this will have the effect of finding an "interior" and "exterior" of the object, with all 

normals either facing in or facing out.

Notes

You can set an object to display its normals by choosing Show Normals. (See Object Display 
Mode.)
Several operations, such as Shell and Boolean, require that an object's normals be aligned in a certain 
way (usually all pointing out).
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Unmark UV Seams

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: UVs/Materials > Unmark UV Seams

Description

This command allows you to un-mark edges on your object which will correspond to edges in UV space 

where the object will be broken apart when unwrapping. Un-marking the seam will immediately result in 

the UV edges being sewn back together. Marking seams is an essential part of the Unwrap UVs Using 

LSCM workflow, but it will also affect UVs unwrapped via any other method.

Notes

See the entry for Unwrap UVs Using LSCM for a description of the LSCM unwrapping workflow.
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Unpin UV Vertices

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: UVs/Materials > Unnpin UV Vertices

Description

This command allows you to un-pin vertices on an object so they will be affected by the Unwrap UVs 

Using LSCM command.

Notes

See the entry for Unwrap UVs Using LSCM for a description of Silo's LSCM unwrapping 
workflow.

Category: Silo Manual



Unselected to Wireframe

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Display > Unselected To Wireframe

Description

The Unselected To Wireframe command will set all objects which are not currently selected (or editable if 

not in object selection mode) to display in wireframe mode.

Notes

This is an easy way to clear the screen of unnecessary objects without hiding them completely.

Category: Silo Manual



Unsubdivide

From Nevercenter 3D Modeling Wiki

Default Shortcut: V

Menu Path: Subdivision > Unsubdivide

Description

The Unsubdivide command will decrease the smoothness of the refined mesh on a subdivided object, 

removing one level of the recursive subdivision. If the object was only subdivided once, this will return it 

to its original non-subdivided state.

Sticky Functionality

Press and hold the keyboard shortcut for this command to temporarily preview the next lower subdivision 

level. Release the shortcut to go back to the current subdivision level.

Notes

See the Subdivide topic for more information on subdivided shapes.
Unsubdivide will be applied to all active objects, no matter the selection mode.
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Unwrap UVs Using LSCM

From Nevercenter 3D Modeling Wiki

Default Shortcut: U

Menu Path: UVs/Materials > Unwrap UVs Using LSCM

Description

Unwraps selected UVs using the LSCM (Least-Squares Conformal Mapping) algorithm, which attempts 

to optimally flatten islands of UVs based on seam edges and pinned vertices marked by the user. The 

flattened object is cut along marked seams (think of them as seams in clothing), while pinned vertices are 

used to denote which UV vertices should not be changed by the algorithm.

This command is very similar to Recreate UVs Using LSCM Unwrapping. The difference is most 

apparent when only some components of an object are selected. This command will unwrap the UVs in 

place, while that command will treat the selection as a new island or set of islands, and scale the results to 

fill the 0-1 UV tile.

Notes

This command can be applied to component selections (such as selected faces) if you only want to 
unwrap UVs for part of the object.
See Mark UV Seams, Unmark UV Seams, Mark UV Seams Toggle, Pin UV Vertices, Unpin UV 
Vertices, and Pin UV Vertices Toggle for more information on marking seams and pinning vertices.
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Use Scene Lights

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Display > Use Scene Lights

Description

When Use Scene Lights is enabled, the scene will be lit by any lights you have created rather than the 

scene's default lighting. To create a light, use the Add Light command.

Notes

There is also a Show Lights command, which will show and hide the geometry for the light so it
isn't in the way while modeling, without affecting the behavior of the lights on objects in the scene.
If you would like the lights to rotate when you rotate the view, like Silo's default lighting, use the 
Lock Scene Lighting to Camera command.

Category: Silo Manual



Viewport Camera

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Display > Viewport Camera

Description

The Viewport Camera submenu allows you to choose the camera for the current viewport. All cameras 

besides the perspective camera are orthogonal ("ortho"). For all cameras except the perspective camera and 

the free orthographic camera, view rotation is limited to rotation in the plane of the work plane.

Silo has two cameras special to UV editing, UV 2D View and UV 3D View. These cameras will only 

display UV Proxies in the UV editing space, and will not display your regular geometry.

Notes

When more than one viewport is on screen at once, only the active viewport's camera is changed 
when this command is called.
There is only one of each type of camera. Multiple viewports with the same camera setting will not 
have independent position and rotation controls.
Camera options can be edited in the Display Settings dialog.
You can set a background image to use as a modeling guide for top, bottom, front, back, left, and 
right orthographic cameras using the Set Viewport Image command.
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Viewport Layout

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Display > Viewport Layout

Description

The Viewport Layout submenu allows you to choose the way your workspace is divided. Each viewport 

can have its own camera assigned to it.

Single View Layout

The entire screen will be filled with a single viewport.

Horizontal Split Layout



The screen will be split horizontally into two viewports.

Vertical Split Layout

The screen will be split vertically into two viewports.

Three View Layout (Left)

The screen will be split into three with the large viewport on the left.

Three View Layout (Right)



The screen will be split into three with the large viewport on the right.

Four View Layout

The screen will be divided into four equal viewports.

Notes

When more than one viewport is on screen at once, the user must first click in another viewport to 
make it active before using that viewport.
You can adjust the relative size of viewports (if you have multiple viewports visible) by clicking and 
dragging on the borders separating them.
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Walkthrough Mode

From Nevercenter 3D Modeling Wiki

Default Shortcut: None

Menu Path: Display > Walkthrough Mode

Description

The Walkthrough Mode option, when checked on the menu, enables a separate set of camera controls 

which mimic a first-person perspective. Rotation occurs around the camera rather than around the 

manipulator, and zoom and pan move with constant speeds rather than being dependent on distance from 

the manipulator.

Notes

This option affects all viewports, not just the active viewport.
The speed of zooming and panning in Walkthrough Mode can be edited in the Display Settings
dialog.

Category: Silo Manual


	Quick Start Guide
	View Controls
	Mouse Controls

	Selection
	Mouse Controls

	Manipulators
	Commands

	Subdivision
	Commands
	Common Usage

	Notes for Mac Users

	Alphabetical List of Commands
	Add Light
	Append Edges
	Append Polygon
	Append
	Arc
	Arrange UVs In Bounds
	Array
	Auto Orient Manipulator
	Bevel
	Boolean
	Break
	Bridge
	Brush Editor
	Button Page 1-9
	Button Settings
	Calculate Symmetry
	Circle
	Clear Higher Subdivision
	Color Settings
	Combine Objects
	Cone
	Constrain
	Context Help
	Convert Selection To
	Copy
	Crease Edges
	Cube
	Custom Primitive
	Cut
	Cycle Shading
	Cylinder
	De-instantiate Instance
	Delete Viewport Image
	Delete
	Deselect Inactive
	Deselect
	Display Settings
	Duplicate
	Edge Tool
	Exit
	Expand Selection
	Export UVs To Image
	Extrude
	Extrusion Object
	File Format Settings
	Fill Hole
	Flatten
	Flip UVs
	Focus Selection
	Frame Selection
	General Settings
	Generate Displacement Map
	Generate Normal Map
	Grid
	Group Selection
	Grow Selection
	Help Manual
	Hide Selection
	Hide Unselected
	Inset Scale
	Instance Mirror Toggle
	Instance
	Invert Selection
	Keyboard Settings
	Lathe Object
	Live UV Unwrapping
	Load All Settings
	Load Into Scene
	Local Move
	Local Scale
	Lock Scene Lighting to Camera
	Make Scene Lights Default
	Manipulator Edit Mode
	Manipulator Tool
	Mark UV Seams Toggle
	Mark UV Seams
	Material Editor
	Merge
	Mirror Geometry
	Mirror UVs
	Mirroring
	Mouse Settings
	Move and Sew
	New Scene
	Next Button Page
	No Function
	Nudge UVs
	Numerical Editor
	Object Display Mode
	Object Properties
	Open Scene
	Orient Manipulator
	Orient Selection To World
	Orient
	Paint Displacement
	Paste
	Path Extrusion Object
	Pin UV Vertices Toggle
	Pin UV Vertices
	Polygon Tool
	Pov Format
	Recenter Object Axis
	Recreate UVs Per Face
	Recreate UVs Using LSCM Unwrapping
	Recreate UVs Using Neighbors
	Recreate UVs Using Planar Regions
	Recreate UVs Using XYZ Coords
	Recreate UVs
	Redo Selection
	Redo
	Refine Control Mesh
	Registration
	Render External
	Repeat
	Restore Symmetry
	Reverse Normals
	Revert To Autosaved
	Rib Format
	Save All Settings
	Save Incremental
	Save Scene As
	Save Scene
	Save Screenshot
	Save Selected Objects
	Scale UVs Proportionally
	Scale UVs To Bounds
	Scene Editor
	Scene Info
	Select Affected Groups
	Select All
	Select Loop
	Select Next Group
	Select Path
	Select Ring
	Select Special Geometry
	Select Viewport Image
	Selection Mode
	Selection Style
	Set Object Axis
	Set Viewport Image
	Shell
	Show All
	Show Buttons
	Show Lights
	Show Manipulator
	Show Viewport Images
	Show Work Grids
	Shrink Selection
	Slide
	Smooth
	Snapping
	Soft Selection
	Sphere
	Spin Edge
	Split Loop
	Subdivide
	Subdivision Settings
	Supported 3D File Formats
	Supported Image File Formats
	Surface Tool
	Symmetry Mode Toggle
	Toggle Current Subdivision
	Topology Tool
	Torus
	Triangulate
	Tutorials
	Tweak
	Uncrease Edges
	Undo Selection
	Undo
	Unify Normals
	Unmark UV Seams
	Unpin UV Vertices
	Unselected to Wireframe
	Unsubdivide
	Unwrap UVs Using LSCM
	Use Scene Lights
	Viewport Camera
	Viewport Layout
	Walkthrough Mode




